© 2013 Adlib

This manual, and the Adlib products to which it refers, is furnished under license and may be used or copied only in accordance with the terms of such license. The content of this manual is provided for informational use only, is subject to change without notice and should not be construed as a commitment by Adlib Publishing Systems Inc. Adlib Publishing Systems Inc. assumes no responsibility or liability for any errors or inaccuracies that may appear in this manual.

Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise without the prior written permission of Adlib Publishing Systems Inc.

Adlib, Adlib Software, Adlib PDF, Adlib Workflows for SharePoint, Adlib Director, the Adlib Software logo, and Adlib logo are either registered trademarks or trademarks of Adlib Publishing Systems Inc. All other trademarks are property of their respective owners.

Portions of this product contain code from OmniPage Capture SDK (registered trademark of Nuance Communications Inc.), Outside In (registered trademark of Oracle), Glyph & Cog, LLC (Copyright 2003-2013), Pegasus Imaging Corporation (Tampa, FL), PDFNet SDK from PDFTron™ Systems (Copyright 2001-2013) and are distributed by Adlib under license.

Adlib Publishing Systems Inc.
215 - 3228 South Service Rd.
Burlington, Ontario
Canada L7N 3H8
Phone: 1-905-631-2875
www.adlibsoftware.com

Printed in Canada.
All rights reserved.
# Table of Contents

1 User Guide Overview .............................................................................................................. 6
   Audience ................................................................................................................................. 6
   User Guide Organization ....................................................................................................... 7
   Typographical Conventions ................................................................................................. 7
   Notes ....................................................................................................................................... 7
   Terminology .......................................................................................................................... 7

2 Adlib PDF .................................................................................................................................. 8
   Key Concepts .......................................................................................................................... 9
   Components ........................................................................................................................... 10
   Overview of the Transformation Process .............................................................................. 11
   Environments .......................................................................................................................... 11
   Sources ................................................................................................................................... 11
   Variables .................................................................................................................................. 11
   PDF Optimization .................................................................................................................. 11
   Rules ....................................................................................................................................... 11
   Common Functions ............................................................................................................... 14
   Adlib Access and Log In ....................................................................................................... 17
   Permissions ............................................................................................................................ 17

3 Management Console ............................................................................................................. 18
   Transformation Functionality ............................................................................................... 19
   Basic Steps ............................................................................................................................. 20
   User Interface Conventions ................................................................................................. 21

4 System Settings ....................................................................................................................... 22
   Overview ............................................................................................................................... 22
   Environments Page ............................................................................................................... 22
      Environment and Component Options ............................................................................... 25
      Action Menu Options ....................................................................................................... 27
      Component Options ......................................................................................................... 30
      Sort Options .................................................................................................................... 31
      Component Initialization Settings .................................................................................... 34
   Sources ................................................................................................................................. 39
      Connectors ......................................................................................................................... 40
      Source Options ................................................................................................................. 41
      Edit Menu Options .......................................................................................................... 44
   Users ..................................................................................................................................... 47
      Variables ............................................................................................................................ 51
         Variable Options ........................................................................................................... 52
      Licensing ......................................................................................................................... 54

5 Job Settings ............................................................................................................................... 55
   Overview ............................................................................................................................... 55
   Job Settings Page .................................................................................................................. 55
   Instruction Sets .................................................................................................................... 56
# 6 Monitoring

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>88</td>
</tr>
<tr>
<td>Monitoring Page Options</td>
<td>89</td>
</tr>
<tr>
<td>Job Status</td>
<td>95</td>
</tr>
<tr>
<td>System Status</td>
<td>102</td>
</tr>
<tr>
<td>System Status Page</td>
<td>103</td>
</tr>
<tr>
<td>System Status Overview</td>
<td>107</td>
</tr>
<tr>
<td>System Status Component Links</td>
<td>108</td>
</tr>
<tr>
<td>Alarms</td>
<td>109</td>
</tr>
<tr>
<td>System Log</td>
<td>111</td>
</tr>
<tr>
<td>System Log Page</td>
<td>113</td>
</tr>
<tr>
<td>Reporting Page</td>
<td>115</td>
</tr>
<tr>
<td>System Load Report</td>
<td>117</td>
</tr>
<tr>
<td>Job Success Report</td>
<td>118</td>
</tr>
<tr>
<td>Job Time Report</td>
<td>119</td>
</tr>
<tr>
<td>Job Volume Report</td>
<td>120</td>
</tr>
</tbody>
</table>

# A Frequently Asked Questions

<table>
<thead>
<tr>
<th>Question</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>How Do I Structure my Job Processing Rules?</td>
<td>121</td>
</tr>
<tr>
<td>What Are the Stages of Job Processing?</td>
<td>125</td>
</tr>
<tr>
<td>How Do I Configure Adlib PDF for High Availability?</td>
<td>126</td>
</tr>
<tr>
<td>How Do I Find Out Why My Job Failed?</td>
<td>127</td>
</tr>
<tr>
<td>What Do I Do if a Component is Generating an Alarm?</td>
<td>131</td>
</tr>
<tr>
<td>Why Can I Not Process Any Jobs?</td>
<td>134</td>
</tr>
<tr>
<td>How Do I Change Logging Levels?</td>
<td>135</td>
</tr>
<tr>
<td>How Do I Get Rid of the Input File Extension in the Rendered PDF?</td>
<td>137</td>
</tr>
<tr>
<td>How Do I Change the Input File Destination After Job Processing?</td>
<td>140</td>
</tr>
</tbody>
</table>

# B Database Growth Management

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Growth Management Modes</td>
<td>142</td>
</tr>
<tr>
<td>Configuring Database Growth Management Settings</td>
<td>143</td>
</tr>
</tbody>
</table>

# C Content Transformation Viewers and Supported File Types

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Native Application Support (NAS)</td>
<td>146</td>
</tr>
<tr>
<td>Adlib Viewer Support</td>
<td>147</td>
</tr>
</tbody>
</table>
User Guide Overview

This guide is intended for Users and Administrators who wish to understand the functionality of the Adlib PDF. The functionality described in this guide is restricted to the Management Console. Other elements of this platform, such as Installation and Integration are available in supporting Adlib guides and reference materials.

Audience
The Adlib PDF User Guide is intended for any user who wishes to understand the basic functionality of the Adlib system. For the purposes of this guide, the term "Users" can refer to:

- System Administrators and IT staff responsible for preparing the Environment, installing, configuring, deploying, managing, troubleshooting and upgrading Adlib PDF.
- Development staff tasked with integrating Adlib PDF into their solution.
- Product Managers who wish to learn about the high level capabilities and integration options of Adlib PDF for use within their own solution.
User Guide Organization
This guide is structured to reflect the organization of the Adlib Management Console. It enables Users to find information quickly based on the task(s) being performed.

Typographical Conventions
The following typographical conventions are used throughout this guide.

<table>
<thead>
<tr>
<th>Item</th>
<th>Convention</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adlib elements</td>
<td>Teal, Title case</td>
<td>The <strong>Folder Connector</strong> integrates with file folders</td>
</tr>
<tr>
<td>Field names</td>
<td>Bold</td>
<td>Type “true” in the <strong>Value</strong> field</td>
</tr>
<tr>
<td>Field values</td>
<td>Enclosed in quotes</td>
<td>Type “true” in the <strong>Value</strong> field</td>
</tr>
<tr>
<td>Logical operators</td>
<td>Uppercase, Bold</td>
<td><strong>AND</strong>, <strong>== EQUALS</strong></td>
</tr>
<tr>
<td>Menu options &amp; titles</td>
<td>Bold</td>
<td>Select <strong>Transformation Rules</strong> from the <strong>Settings</strong> menu</td>
</tr>
<tr>
<td>Push buttons</td>
<td></td>
<td>Click <strong>Save</strong></td>
</tr>
<tr>
<td>Settings</td>
<td></td>
<td>Drag <strong>Active</strong> from the <strong>Settings toolbox</strong></td>
</tr>
<tr>
<td>Page elements and titles</td>
<td>Italic</td>
<td>Navigate to the <strong>Edit</strong> tab on the <strong>Rule Set Editor page</strong></td>
</tr>
<tr>
<td>Window titles</td>
<td></td>
<td>Drag <strong>Active</strong> from the <strong>Settings toolbox to the work area</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Define Attribute Settings in the <strong>Edit Attribute window</strong></td>
</tr>
<tr>
<td>Script</td>
<td>Mono code</td>
<td><code>${Adlib.FolderConnector.InputFileExtension}</code></td>
</tr>
<tr>
<td>URLs</td>
<td>Lowercase</td>
<td><a href="http://www.adlibsoftware.com/">http://www.adlibsoftware.com/</a></td>
</tr>
<tr>
<td>User-defined element</td>
<td>Enclosed in angle brackets</td>
<td>C:\Program Files\Adlib&lt;Install Folder&gt;</td>
</tr>
</tbody>
</table>

Notes
Notes, cautions and tips are offered throughout the guide and are quickly identified by the following icons:

- Provides informational notes relevant to the content.

- Provides important cautionary notes relevant to the content.

- Provides helpful tips and shortcuts.

Terminology
Detailed descriptions of terminology applicable to the Adlib product can be found in the Adlib Glossary.
Adlib PDF is the next generation of Adlib transformation technology. Its design offers a high degree of flexibility for developing systems that provide scalability and high availability. An intuitive, interactive interface enables administrators to set up, configure, and troubleshoot systems that are easily configured to fulfill each user’s unique requirements.

Adlib PDF offers scalability and load balancing potential for the efficient use of system resources to maximize the volume of document conversions. Processing can be prioritized to ensure that time-critical work is done first. Health monitoring provides a window into the centralized database and instant notification of system issues, which can minimize time spent troubleshooting. Performance measurement through reporting can identify performance bottlenecks and verify that Service Level Agreements are being met. Potential issues can be anticipated and future upgrades in capacity can be planned and implemented before service is compromised.

- Key Concepts
- Components
- Overview of the Transformation Process
- Environments
- Sources
- Variables
- PDF Optimization
- Rules
- Common Functions
- Adlib Access and Log In
Key Concepts

The process of document transformation begins when a Connector detects input in a Source repository that it is monitoring. When a new job becomes available, the Connector extracts the content from the Source and submits it to the Job Management Service. The Job Management Service evaluates the associated Job Acceptance rule(s) and if accepted, submits the accepted job to the database.

The System Manager is constantly polling the database for jobs it can process. When a new job is detected, the System Manager evaluates the Transformation rules associated with the content from that Source, creates a job ticket and submits the ticket to the database. The Transformation Engine picks up the job, performs the transformation according to the job ticket and writes the completed job back to the database. The Connector, which has been polling the database for completed jobs, uploads the transformed job into the Source output folder or repository.

In addition to the Components that perform content transformation, Adlib PDF contains a Process Manager whose role it is to stop, start and monitor the Transformation Engine, Connector(s) and System Manager. The System Manager also monitors the health of Adlib PDF Components and reports alerts to the system administrator.

Figure 1 - Key Concepts
Components
Adlib PDF comprises several Components to interface with users, manage jobs, perform transformations, monitor services, and report system and job status. Adlib PDF includes the following Component types:

Connectors
A Connector Component monitors a Source for content, submits the content as a job to Adlib PDF, and receives completed job output.

Different types of Connectors integrate with various Source types:
- The Folder Connector integrates with Folder Sources.
- The Generic Connector integrates with the Web Service interface.
- The SharePoint Workflow Connector integrates with Microsoft SharePoint via workflows.
- The Documentum Connector integrates with EMC Documentum.
- The Exchange Connector integrates with Microsoft Exchange.

Job Management Service
This is a service interface within Adlib PDF used to submit and receive Jobs. It is called by Connectors and custom integrations. Currently, two Job Management Service Components will be installed with Adlib PDF; one for use with a Generic (Custom) Connector, the other for use with the other Adlib Connectors.

Logger
These Components log data into the Adlib PDF database.

Process Manager
These Components control individual processes on a single machine within the Adlib system. Its role is to start, stop, monitor, and restart the processes assigned to it.

There is one Process Manager Component installed on each machine on which any Adlib Components, such as Folder Connector, are installed.

Services
This is a layer of communication services used primarily by the Management Console.

System Manager
These Components manage jobs and monitor all Adlib PDF Components. They prepare jobs for the Transformation Engine by executing the appropriate Transformation Rule Sets. They also monitor the health of Components and issue alerts to the System Administrator.

Transformation Engine
This Component performs the transformation of content.
Overview of the Transformation Process

In the most basic implementation of Adlib PDF, the user begins the transformation process by placing a document in a particular input repository, called a "Source". A Source can be a folder, content management systems (e.g. Microsoft SharePoint), or a repository that is custom designed according to the needs of the user. The document is then evaluated by a set of rules called an "Instruction Set".

There are two types of rules within an Instruction Set - rules that determine if the content should be accepted for transformation, called "Job Acceptance" rules, and rules that define how that transformation should take place, called "Transformation Rules". The flexibility of Adlib PDF to create rules to suit almost any business application is further enhanced with the use of metadata within rules. Metadata, which is "data about data", can be associated with the content to be processed, such as the document template or file type, or it can be related to one of the Adlib PDF Components. For example, Component metadata could be used to determine which Transformation Engine group should process the content transformation.

Once the document as been evaluated against the relevant Instruction Set, it will be prepared according to the specifications in the rules. Adlib PDF performs the transformation and deposits the output in the specified output folder or repository.

Environments

An Environment is a group of registered Components that are assigned for use in Adlib PDF. Components must be assigned to an Environment to be activated. Each Component can only be assigned to a single Environment. Based on the licensed usage, Components may be installed in a single server deployment, or in a multiple-server Environment for scalability and high availability.

Sources

A Source is a repository or structured container of digital content where input documents and metadata are drawn from. These include file folders, content management systems (e.g. SharePoint), or custom Sources built through web services. Sources must be associated with a Connector, and then assigned to an Instruction Set before input can be transformed. The content input and output folders must also be designated in the Source configuration.

Variables

Local Variables are used within Rule Sets to simplify Rule structure. For example, where complex conditions are repeated throughout a Rule Set, these conditions can be evaluated once and assigned to a local Variable which can be referenced multiple times within a Rule Set.

Global Variables can be used throughout Adlib PDF to define names for metadata. For example, where a transformation Rule evaluates the author of an incoming document, the author value could be defined as a metadata name which could then be referenced in the Metadata Selector.

PDF Optimization

By default, duplicate fonts, images, ICC profiles and other data streams are removed when jobs are processed in order to produce optimized PDF output. Image down-sampling settings can also be configured according to user requirements. For more information on the options available in the Optimize Transformation Rule Setting, see the Adlib PDF Technical Reference Guide.

Rules

Rules are declarative statements that apply one or more Settings when its associated Rule Condition evaluates to true. They form the core functionality of Adlib PDF, allowing any calling function to make
decisions based on *metadata*.

Metadata

The term *metadata* refers to data that describes other data. Metadata in the context of a document includes its subject and author (e.g. *Author* = “John Smith”). Rules use conditions evaluated from metadata to:

- Define initialization Settings.
- Identify when rendition requests are denied.

Refer to [Using Metadata](#) for more information on metadata selection.

Rule Composition

Rules consist of three components:

- **Name**
  - Name used to identify the Rule
  - Indicates the general purpose of the Rule
  - Optional description provides more information

- **Condition**
  - Evaluations used to determine when to run a Rule based on metadata values
  - Conditions evaluate to either True or False
  - Can be used to stop processing based on the condition result (*referred to as Exit Flags*)

- **Settings**
  - Based on metadata values
  - Comprised of four elements: Name, Description, Data Type, and metadata Value
  - Multiple Settings allowed for each Rule

Rule Sets

Rule Sets are collections of related Rules. Rules within Rule Sets have a defined execution order and are forward-chaining. Three Rule Set types are used within the Adlib PDF:

- **Component Initialization Rule Sets** define configuration Settings for initialization of Components within an Environment.

- **Job Acceptance Rule Sets** define criteria that constitutes acceptance or denial of a job based on metadata values.

- **Transformation Rule Sets** define conversion Settings for the job.
Rule Set Editor

Rule Sets are defined and configured on the Rule Set Editor page, accessed from either Environments or Job Settings.

- The Active tab displays published Rule Sets. Active Rule Sets may be viewed but not modified.
- The Edit tab is used to create or modify Rule Sets that are inactive.

Rule Logic

The proper utilization of Rule logic can help minimize the number of Rules required to achieve the desired results. Logical ANDs and ORs are used to define Rule Conditions.

For example, to apply PDF security on all Word, Excel, Power Point, GIF and TIFF files, define five separate Rules, one for each file type, each applying the same security Settings.

Alternatively, reduce this to a single Rule by using logical ORs between each file type.

Rule Ordering

Rules always evaluate in the order they appear in the Rule Set (top down). The order of Rule evaluation can greatly affect the outcome.

When building Instruction Set, place general, broader Rules at the top of the Rules list and place specific Rules near the bottom. Place Default Rules, those that apply to all at, the very bottom of the list.

Default Rule

Default Rules always evaluate to True. Locate these at the bottom of the Rules list so they are only evaluated if ALL other Rules evaluate to False with no Exit Flags.

Default Rules should only contain attributes that need to be set for ALL jobs, regardless of metadata values.

Exit Flag

Exit Flags stop the processing of Rules when a Rule Condition occurs. They can be easily identified by a red “stop” icon. The “T” or “F” in the center of the icon identifies a True or False Rule Condition.

Figure 2 - Exit Flag

Exit Flags are primarily used to stop processing when a Rule is encountered that rejects the job. However, any Default Rule that resides at the bottom of the Rules list will ALWAYS be evaluated regardless of previous Rule Conditions, unless an Exit Flag is set to stop processing.

Jobs

A job is a request submitted to Adlib PDF for work to be performed. A job contains metadata that is used to determine how it will be processed.
Job Settings
Job Settings are a collection of settings associated with a job that define how it will be processed. Job Settings can be defined and aggregated through the use of Rules.

Instruction Sets
A user-defined group of Rule Sets that are evaluated on a per job basis when documents arrive in a connected Source. Each Instruction Set is associated to one or more Sources.

Common Functions
The following elements are common throughout the Management Console user interface:

About Button
Provides copyright and licensing details

Breadcrumbs
Displays the current screen location within the Management Console hierarchy and provide links to previous pages in the screen hierarchy. Down arrows, when available, provide quick navigation to other Settings.

Drag-and-Drop
The process of assigning Settings through a graphical operation by dragging them from the toolbox to a drop zone in the work area. A border encompasses the work area during this operation.

Action Drop-Down Menu
Displays action options in a drop-down menu.
**Filter Drop-Down Menu**
Restricts the display of details to a single parameter, selected from a drop-down list.

**Filter Pop-Up Window**
Restricts the display of log details using specific criteria.

**Help Center Button**
Opens the *Help Center* page providing access to Adlib PDF documentation.

**Help Icon**
Opens help content for the current Management Console screen.

**Information Icon**
Displays name and description properties.
Refresh Button
Available on Monitoring pages to refresh job or system details.

Configure Drop-Down Menu
Displays Configure options in a drop-down menu.

Sort Drop-Down Menu
Re-orders page details to display content in the order selected from the drop-down list.

Status Message
Provides information on recent actions.

Publish Icon
A green caution icon indicates that unpublished changes have been detected. To publish and activate the changes, click the icon.

Tool Tips
Right-click and select “What's This” on Settings fields for pop-up descriptions.

Show/Hide Icon
Click the chevron to the right of the About button to minimize the tabs across the top of the screen (Home, System Settings, etc.) and maximize screen space. Click the symbol again to reveal the tabs.
Adlib Access and Log In

Adlib PDF is an account-based web application, requiring users to Log In using their assigned credentials.

- Enter Username and Password, then click Submit.

*Figure 3 - Adlib Log In*

- Click Log Out at the top of any page to exit Adlib PDF.

*Figure 4 - Log Out*

Permissions

Based on their role and responsibilities, users are assigned Administrator, Contributor or Reader permissions.

- Users with Reader permissions have read-only access and may view and open items (Environments, Sources, Job Acceptance Rules, Transformation Rules, etc.). Read permission is selected by default.

- Users with Contributor permissions have read/write access and may view, add, edit, and delete items (Environments, Sources, Job Acceptance Rules, Transformation Rules, etc.).

- Users with Administrator permissions have full access to all features. They have read/write permissions, may access secure information, and are responsible for user account management.

Contact your Administrator to create a user account or to change your permission level.
Management Console

The web-based administrative console provides centralized management of Adlib PDF for system configuration, health monitoring, and reporting.

The Home page provides an overview of the Management Console with Quick Access shortcuts to three functional areas:

- **System Settings** to configure Environments, Sources, Users, and Variables.
- **Job Settings** to configure Job Acceptance and Transformation Rules.
- **Monitoring** to monitor and troubleshoot job and system Components and to generate Reports.

A System Status Overview provides a graphical view of the health status of Adlib system Components.

*Figure 5 - Management Console Home Page*
Home Page
The Home page provides quick links to other areas of the Management Console and a System Status Overview. The System Status Overview visually identifies the health status of all working Components of Adlib PDF and provides access to status logs to troubleshoot any issues. Each box in the Overview represents a Component category.

- Status indicators provide warnings when Components are in a faulted or stalled state.
- Clicking on a Component box in the Overview opens the System Status page, filtered to display status information for the selected Component category.

Refer to System Status Overview within Monitoring for details.

System Settings Page
Use the System Settings page to configure system Components, define Sources of content, manage Users, and define system Variables.

Refer to System Settings for details.

Job Settings Page
Use the Job Settings page to define job processing Instruction Sets and to associate them with Sources of content.

Refer to Job Settings for details.

Monitoring Page
Use the Monitoring page, in conjunction with the System Status Overview, to monitor Component health, troubleshoot failure issues, and generate reports on job and system performance.

Refer to Monitoring for details.

Transformation Functionality
Using the transformation functionality of Adlib PDF:

- Components are assigned to an Environment and configured,
- Sources are defined as repositories of documents to be transformed,
- Instruction Sets, comprising processing Rules for Job Acceptance and Transformation, are configured,
- Connectors are assigned to integrate Environment Components and Sources with Instruction Sets,
- Monitoring provides insight into system and job performance and provides Reports generated from log data.
Basic Steps

Setup, configuration, and use of Adlib PDF can be completed in five basic steps:

1. Define an Environment
   - Navigate to the Environment tab on the System Settings page.
   - Use the Default Environment provided or follow instructions To Define a New Environment.

2. Define Source
   - Navigate to the Sources tab on the System Settings page.
   - Use the Default Source provided or follow instructions To Define a New Source.

3. Configure Job Settings
   - Navigate to the Job Settings page.
   - Use the Default Instruction Set provided or follow instructions to To Define a New Instruction Set.
   - Optionally, follow instructions To Define Job Acceptance Rules.
   - Optionally, follow instructions To Define Transformation Rules.
   - Follow instructions to Publish an Instruction Set.

4. Verify System Readiness
   - Navigate to the Home page.
   - If the System Status Overview indicates that any Components are in alarm state, follow the instructions To Acknowledge Alarms.

5. Submit Job
   - Ensure all the previous steps are complete and Adlib PDF is up and running error free.
   - Submit a document to be converted:
     - Ensure input documents are available for the defined Source.
     - When the Source detects the arrival of the document, it submits a job for processing.
   - Navigate to the Job Status tab on the Monitoring page to view job information.
   - If the job did not complete successfully, refer to Monitoring or Troubleshooting to diagnose the problem.
   - Open the output location defined for the Source to view results.
### User Interface Conventions

The following terms are used throughout this guide to describe common elements within the user interface:

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>When Components are not operating normally (Started, Stopped or Installed status), users are alerted with flashing status indicators on the System Status Overview.</td>
</tr>
<tr>
<td>Database</td>
<td>A collection of data related to Adlib PDF (e.g. Components, Rule Sets, Job configurations, Environments, Job Status Information, System Log details, etc.).</td>
</tr>
<tr>
<td>Drop Zone</td>
<td>A specific location within the work area where dragged Settings are dropped.</td>
</tr>
<tr>
<td>Heartbeat</td>
<td>Identifies the health status of Components in Adlib PDF.</td>
</tr>
<tr>
<td>Publishing</td>
<td>The process of taking Environments or Instructions Sets from edit mode and making them active.</td>
</tr>
<tr>
<td>High Availability</td>
<td>Multiple instances of the same Component that allow Adlib PDF to continue operating in the event that one or more Components fail. Also referred to as Redundancy.</td>
</tr>
<tr>
<td>Toolbox</td>
<td>The location on a page where items that can be dropped into the Work Area reside. Toolbox items include the following: Source Types, on the Sources page, Unassigned Sources, on the Job Settings page, and Rule Conditions, Settings, and Saved Settings on the Rule Set Editor page.</td>
</tr>
<tr>
<td>Work Area</td>
<td>The location on the page where Settings are configured, available on Environments, Sources, Job Settings, and Rule Set Editor pages.</td>
</tr>
</tbody>
</table>
System Settings

Overview
System Settings provides functions for configuring Adlib PDF. Four tabs provide general system functions to:

- Configure installed Components within the Environments Page.
- Define Sources of documents to be transformed.
- Manage Users and assign roles.
- Manage Global Variables.
- Review Licensing information.

Environments Page
Environments define the working system in which Components reside. Components must be assigned to an Environment to be activated. Components may be installed in a single server deployment, or in a multiple-server Environment for scalability and high availability. Each Component can only be assigned to a single Environment. Environment Components include:

- System Manager
- Job Management Service
- Transformation Engine
- Process Manager
- Logger
- Folder Connector
- Generic Connector
- Exchange Connector
- SharePoint Workflow Connector
- Documentum Connector

The Environments tab on the System Settings page, displays a toolbox of installed Components on the left and a work area where Environments are configured on the right. Defined Environments are displayed in the work area.

Within the Environment box, a drop zone identifies the area where Components are assigned.

Components must be assigned to become active.
Components
Environments must include at least one of each of the Functional Components and one or more of the Connector Components, described below:

<table>
<thead>
<tr>
<th>Functional Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Management Service</td>
<td>This is a service interface within the Adlib PDF used to submit and receive Jobs. It is called by Connectors and custom integrations. Currently, there are two Job Management Service Components installed with Adlib PDF. One, identified by the install path: C:\Program Files\Adlib\Web\JobManagementService\bin on the Systems Settings page in the Management Console is a WCF-based Service for use with a Generic (Custom) Connector. The legacy Job Management Service, identified by the path: C:\Program Files\Adlib\Web\DirectorWSA\bin is used by the other Adlib PDF Connectors. Users can choose to install either an IIS-based or Self-hosted Job Management Service.</td>
</tr>
</tbody>
</table>
**Process Manager** These Components control individual processes on a single machine within the Adlib system. Its role is to start, stop, monitor, and restart the processes assigned to it. One Process Manager Component is installed on each machine on which any Adlib Components, such as Folder Connector, are installed.

**Services** This is a layer of WCF-based (*Windows Communication Foundation*) services used primarily by the Management Console. User can choose to install either IIS-based or self-hosted Services.

**System Manager** These Components manage jobs and monitor all Adlib PDF Components. They prepare jobs for the Transformation Engine by executing the appropriate Transformation Rule Sets. They also monitor the health of Components and issue alerts to the System Administrator.

**Transformation Engine** This Component performs the transformation of content.

<table>
<thead>
<tr>
<th><strong>Functional Component</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Manager</td>
<td>These Components control individual processes on a single machine within the Adlib system. Its role is to start, stop, monitor, and restart the processes assigned to it. One Process Manager Component is installed on each machine on which any Adlib Components, such as Folder Connector, are installed.</td>
</tr>
<tr>
<td>Services</td>
<td>This is a layer of WCF-based (<em>Windows Communication Foundation</em>) services used primarily by the Management Console. User can choose to install either IIS-based or self-hosted Services.</td>
</tr>
<tr>
<td>System Manager</td>
<td>These Components manage jobs and monitor all Adlib PDF Components. They prepare jobs for the Transformation Engine by executing the appropriate Transformation Rule Sets. They also monitor the health of Components and issue alerts to the System Administrator.</td>
</tr>
<tr>
<td>Transformation Engine</td>
<td>This Component performs the transformation of content.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Connector Component</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder Connector</td>
<td>Integrates with Folder Sources.</td>
</tr>
<tr>
<td>Generic Connector</td>
<td>Integrates with the Web Service Interface.</td>
</tr>
<tr>
<td>Exchange Connector</td>
<td>Integrates with Microsoft Exchange</td>
</tr>
<tr>
<td>SharePoint Workflow Connector</td>
<td>Integrates with Microsoft SharePoint via workflows.</td>
</tr>
<tr>
<td>Documentum Connector</td>
<td>Integrates with EMC Documentum</td>
</tr>
</tbody>
</table>
**Environment and Component Options**

The first requirement to use Adlib PDF is to define an Environment and assign Components. Once Components are configured, Environments are published, placing all Components into active mode. A default Environment is provided when Adlib is installed.

**To Define a New Environment**

1. On the **Environments** page, click **New Environment**.

   *Figure 7 - New Environment button*

2. When prompted, type the Environment **Name** and optional **Description** in the **Properties** window.

   *Figure 8 - Environment Properties*

3. Assign one or more Components to the Environment by dragging Component(s) from the **toolbox** to the **work area**.

   **TIP**

   A border encompasses the **work area** during a drag-and-drop operation.
The **Action** menu in the Environment's **work area** provides the following options:

- **Delete Environment**
- **Import an Environment**
- **Export an Environment**
- **Publish Environment**
- **View Environment Properties**

**Figure 10 - Environment Action Menu**

The following **Sort** options enable Environments and Components to be reordered on the **Environments** page:

- **Sort Environment List**
- **Sort Environment Components**
- **Sort Unassigned Components**
The following Component options provide additional functionality:

- Remove Environment Components
- Unregister Environment Component
- View Component Details

**Action Menu Options**

**View Environment Properties**
Select Properties from the Action menu to view or update the Environment Name or Description in the Environment Properties window.

**Delete Environment**
Only Environments with NO assigned Components may be deleted.
1. Select Delete from the Action menu.
2. When prompted, click OK to confirm deletion. A status message confirms successful deletion.

**Export an Environment**
Export Environment settings to a file, for reuse in another Environment.

- Environments in either Edit or Active mode may be exported.
1. Select **Export** from the Action menu.
2. In the **Export Environment** window, select the **Rule Set Types** to be exported or **Select All**.
3. Click the ellipsis button to define the export file name and location.
4. Click **Export**. A status message confirms if the export was successful.

*Figure 11 - Export Environment*

![Export Environment Window](image)

**Import an Environment**

Import Environment settings from a previously exported file.

Files may only be imported to Environments that are in Edit mode.
1. Select **Import** from the Action menu.
2. When prompted, browse to the Environment file and click **Open**.
3. In the *Import Environment* window, select to import the Environment in either **Active** or **Edit** state.
4. Select the **Rule Set Types** to be imported.
5. Click **Import**. A status message confirms if the import was successful.

   *Figure 12 - Import Environment*

   ![Import Environment](image)

   **Publish Environment**

   Publishing an Environment places all Environment Components into **Active** mode.

   1. Select **Publish** from the Action menu or click the Publish icon. A status message confirms publication.

   *Figure 13 - Publish Icon*

   ![Publish Icon](image)
Component Options

Remove Environment Components

Removing a Component from an Environment and stopping the Process Manager stops all operations performed by that Component. For example, removing a Source will stop all jobs submitted by that Source; removing an Engine will stop any additional jobs being sent to that Engine.

- Drag the Component to be removed from the Environment’s work area to the Unassigned Components toolbox.

Only Components that are NOT currently assigned to a Source may be removed from an Environment.

- Uninstall the Component from the database.

Unregister Environment Component

Components that no longer reside in the database need to unregistered. This is required if the Component was uninstalled without first being unassigned from an Environment or if the machine on which the Component resided is no longer available.

1. Unassign the Component from the Environment.
   - Drag the Component from the Environment’s work area to the Unassigned Components toolbox.

2. In the Unassigned Components toolbox, click the arrow beside the Component name.
3. Click Unregister. When prompted for confirmation, click OK.

Figure 14 - Unregister Component
Sort Options

↓ Sort Environment List

When multiple Environments have been defined, the order in which the Environments are listed may be changed.

1. Click the Sort down arrow above the Environment list to open the Sort menu.
   - Click Name to order the list by the Environment name.
   - Click None to leave the list in the order in which the Environments were added.

Figure 15 - Sort Environment List
**Sort Environment Components**

When multiple Components have been assigned to an Environment, the order in which Components are listed may be changed.

1. Click the **Sort** down arrow within an Environment work area to open the Component Sort menu.
   - Click **Machine Name** to sort Environment Components by the name of the machine on which the Component resides.
   - Click **Component Type** to sort Environment Components by the type of Component (*Folder Connector, Services, etc.*)

*Figure 16 - Sort Environment Components*

**Sort Unassigned Components**

1. Click the **Sort** down arrow at the top of the toolbox to open the Unassigned Components Sort menu.
   - Click **Machine Name** to sort Unassigned Components by name of the machine on which the Component resides.
   - Click **Component Type** to sort Unassigned Components by their type.

*Figure 17 - Sort Unassigned Components*
**View Component Details**

Click the arrow beside a Component name to display or hide Component details, including the name of the Component and the path where the Component is installed.

*Figure 18 - Component Information*
**Component Initialization Settings**

Once Components are assigned, they are configured for the Environment in which they are assigned.

- Ensure that all paths used in Component Settings conform to the Windows limit of <260 characters.

- Select the Component to be configured from the **Configure** menu. The **Rule Set Editor** page displays settings specific to the Component selected.

*Figure 19 - Environment Configure Menu*

---

**Rule Set Editor Page**

The **Rule Sets Editor** page displays a **work area** where Rule Sets are defined, and a **toolbox** from which Rules and Settings are assigned.

- The **Active** tab (**opens by default**) displays published Rule Sets. Active Rule Sets may be viewed but are locked from editing.

- The **Edit** tab is used to create or modify Rule Sets that are inactive.

Drag a Rule from the **toolbox** to the **rule drop zone**. Drag a setting from the **toolbox** to the **setting drop zone**. **Edit Menus** provide options to configure Rules and settings.

- All changes to System Settings must be activated by publishing the Environment in which the Components reside.
System Manager

System Manager Components manage jobs received via web services and monitor other Components.

- **System Manager** to define settings specific to System Manager (e.g. intervals, maximum counts, e-mail settings, completed job retention, database growth management),

  For more information on the Database Growth Management application settings and defaults, see [Database Growth Management](#).

- **Output Mapping** to define file extension mapping for Output documents (for example, Microsoft Word output documents map to .doc file extension, PDF output documents map to .pdf file extension).
Job Management Service

Job Management Service Components manage jobs. Both the legacy and WCF-based Components employ the same Rule Settings:

- **Job Management Service** to define settings specific to Job Management Service *(e.g. intervals, e-mail settings, job log retentions)*,
- **Boolean, Integer, and String Variables**.

Transformation Engine

Transformation Engine Components perform the transformation of files. Settings include:

- **Transformation Engine** to define settings specific to the Transformation Engine *(e.g. intervals, limits, stored procedure name, job filters, group name)*,
- **Engine Registry** to configure settings related to system fault monitoring and recovery (FMR). The defaults set at installation can be modified as necessary.
  - **Restart**: Enabling Restart causes the Transformation Engine to automatically shut down and restart after processing the specified number of documents. This function was implemented to maximize Adlib’s reliability and to recover memory consumed by the Windows Operating System and application software (e.g. Microsoft Word, Excel, etc.) This setting is enabled by default after 300 documents.
  - **Job Timeout**: A Job Timeout occurs when any Job takes longer to process than the specified timeout period. Regardless of whether or not the Transformation Engine is still sending messages to Adlib FMR, if the Job takes longer than the timeout specified, the Job is terminated. The Job Timeout setting is disabled by default. Note: The recommended Job Timeout length is 1200 seconds at the minimum; this length should be increased if large jobs are regularly processed.
  - **Inactivity Timeout**: The Inactivity Timeout occurs when absolutely no messages are returned by the Transformation Engine within the specified timeout period. The document conversion is terminated. This setting is enabled by default after 600 seconds.

The True/False values must be used to enable or disable the Engine Registry Settings; simply clearing a checkbox will not disable a setting.

Process Manager

Process Manager Components are responsible for launching and monitoring Adlib Components. Settings include:

- **Process Manager** to define settings specific to the Process Manager *(e.g. acknowledge logon message, keep alive interval)*,
- **Executable** to define settings for launching an Executable *(e.g. path, parameters, username, session, etc.)*,
- **Folder Connector** to define settings for launching a Folder Connector *(e.g. path, parameters, username, etc.)*,
- **Service** to define settings for launching a Window Service *(e.g. service name)*,
- **System Manager** to define settings specific to the System Manager *(e.g. service name, component)*,
- **Transformation Engine** to define the settings specific to the Transformation Engine (*e.g.* path, parameters, directories, run attributes),
- **Users** to define Users (*e.g.* usernames, passwords, descriptions).

**Logger**

Logger Components manage job logging and diagnostics. Settings include:

- **Context List**
- **Context Refresh Interval**
- **Log Settings**

**Folder Connector**

Folder Connector Components integrate with monitored folders. Settings include:

- **Behavior Settings** to define Job Folders and Job Files behavior (*e.g.* error and work folder locations, input and output file naming/handling, etc.),
- **Boolean, Integer, and String Variables**,
- **Helper Applications** to define the Connector Helper Applications (*e.g.* class name, context, execution attributes),
- **Submitter Performance** to define settings specific to Connector submitter performance (*e.g.* thread pool, job throughput),
- **Receiver Performance** to define settings specific to Connector receiver performance (*e.g.* thread pool, job throughput),
- **Sources** to define the Source configuration value.

**Generic Connector**

Generic Connector Components integrate with the Web Service interface. Settings include:

- **Generic Connector** to define custom Connector settings.

**Exchange Connector**

The Exchange Connector integrates Microsoft Exchange with Adlib PDF. Settings include:

- **Behavior Settings** to define Job Folders and Job Files behavior (*e.g.* error and work folder locations, input and output file naming/handling, email content, etc.),
- **Boolean, Integer, and String Variables**,
- **Helper Applications** to define the Connector Helper Applications (*e.g.* class name, context, execution attributes),
- **Performance** to define settings specific to Connector Performance (*e.g.* thread pool, job throughput),
- **Sources** to define the Source configuration value.

**SharePoint Workflow Connector**

The SharePoint Workflow Connector integrates Microsoft SharePoint with Adlib PDF. Settings include:
Filter Submission Metadata to define submission metadata settings,
Retrieve Data Activity to define retrieval settings,
Send E-mail Activity to define settings for e-mail, attachments, credentials, etc.,
Submit Documents From SharePoint Activity to define settings for submitting documents from SharePoint,
Submit Documents to SharePoint Activity to define settings for submitting documents to SharePoint,
Workflow to define workflow settings.

Refer to the Adlib PDF SharePoint Workflow Connector Guide for further details on the SharePoint Workflow Connector.

Documentum Connector
The Documentum Connector Component integrates EMC Documentum with Adlib PDF. Settings include:

- Behavior Settings to define Job Folders and Job Files behavior (e.g. processing locations, input and output handling, DQL settings and job metadata names, etc.),
- Helper Applications to define the Connector Helper Applications (e.g. class name, context, execution attributes),
- Performance to define settings specific to Connector Performance (e.g. thread pool, job throughput),
- Local Log Settings to define the Log4j local log settings,
- Sources to define the Source configuration value.

Refer to the Adlib PDF Documentum Connector Guide for further details on the Documentum Connector.
Sources

Sources are repositories of content where input documents and metadata are drawn from. These include folders, content management systems (e.g. SharePoint), or generic Sources built through web services. Adlib can receive content from any number of Sources.

The Sources page, accessed from the System Settings tab, displays a work area where Sources are defined, and a toolbox from which installed types of document Sources (e.g. Folder, SharePoint, Generic) are assigned. Define a new Source by dragging a Source Type from the toolbox to the source drop zone in the work area.

Figure 22 - Sources Page
Sources are monitored for activity by an assigned Connector. A default Source is provided when Adlib is installed.

By default, Sources are displayed in order by Name. However, the sort order may be changed using the **Sort Menu**.

A **Filter Menu** restricts the Source list by Source type.

The **Action Menu** provides options to edit and delete defined Sources.

An **Information** icon displays Source descriptions.

**Connectors**

Connector Components integrate with external systems, monitoring input Sources for activity, delivering input documents and metadata for processing, querying for job completion, and delivering results. Different types of Connectors integrate with various Source Types:

- The **Documentum Connector** integrates EMC Documentum with Adlib PDF.
- The **Folder Connector** integrates with file folders.
- The **Generic Connector** integrates with the Web Service Interface.
- The **Exchange Connector** integrates with Microsoft Exchange.
- The **SharePoint Workflow Connector** integrates Microsoft SharePoint with Adlib PDF.
Source Options
Define Sources and assign Connectors.

To Define a New Source
1. On the Sources page, drag a Source Type from the toolbox to the work area.

Figure 23 - Drag-and-Drop Sources

2. When prompted, type a Name and optional Description in the Properties window.

Figure 24 - Source Properties

3. Select Edit from the Edit menu to configure the Source.

Figure 25 - Source Edit Menu
For **Documentum Source Types**, identify the **Docbase** name and **User** credentials. For more information on using the **Documentum Connector** see the Adlib PDF Document Connector Guide.

*Figure 26 - Documentum Source Type*

For **Folder Source Types**, identify folder locations. These must be accessible by the machine on which the **Folder Connector** Component is installed.

- The **Input** folder identifies the location the Connector checks for activity (*where files to be transformed are placed*).
- The **Output** folder is where processed files are located.
- For system redundancy, two **Folder Connector** Components can be assigned to the same Source. To assign a second Connector, click the plus (+) symbol and select the name of the Connector from the drop-down list. **Note**: only one Folder Connector can be installed on each machine.

*Figure 27 - Folder Source Type*

For **Generic Source Types**, identify the **Connector Name** and **Description**.

*Figure 28 - Generic Source Type*

For **SharePoint Workflow Source** types, identify the Mapping **Name** and **Value** if multiple Sources will be created. For more information on using the **SharePoint Workflow Connector**, see the Adlib PDF SharePoint Workflow Connector Guide.
4. Add a Connector to monitor the Source.
   - Select the Connectors plus sign, then click the Connectors down arrow and select the appropriate Connector type from the drop-down list.

5. Click Save.

6. As a final step, the Process Manager must be restarted to reinitialize the Connector to recognize any new Sources that have been added to the system. To do so, select Control Panel from the Windows Start menu, then open Administrative Tools/Services. Select the Adlib Process Manager Service, and click Restart the Service.
The **Edit** menu in the Source’s *work area* provides the following options:

- **Delete a Source**
- **View or Modify Source Properties**
- **Modify Source Connectors**

The following options provide options to sort or filter source details:

- **Sort Sources**
- **Filter Sources**

### Edit Menu Options

**↓ Delete a Source**

Sources may only be deleted if no Connectors are assigned.

1. Select **Delete** from the Edit menu.
2. When prompted, click **OK** to confirm. A status message confirms successful deletion.

**TIP**

Click the pencil to quickly enable Edit mode.
View or Modify Source Properties
1. Select Properties from the Edit menu.
2. Update the Source Name or Description and click Save.
3. To view Source information, hover over the Information icon.

Figure 33 - Source Information

Modify Source Connectors
1. Select Edit from the Edit menu.
2. To remove a Connector,
   • Click the X beside the Connector name.
3. To change a Connector,
   • Click the down arrow beside the Connector name and select another Connector from the drop down list.

Sort Sources
Click the Sort down arrow to open the Sort menu.
   • Select Name to order the list of Sources by Source Name.
   • Select By Type to order the list of Sources by Source Type.

Figure 34 - Sources Sort Menu.

Filter Sources
Click the Filter down arrow to open the Filter menu.
Select a **Source Type** from the drop-down list to restrict the list of Sources to that Source Type only.

*Figure 35 - Sources Filter Menu*
Users

The Users tab enables Administrators to create and manage Adlib PDF users that have access to the Management Console. The assigned User Name and Password are required for the user to log in to Adlib.

It is not necessary to register Users that submit content.

The Users page provides the following options:

- Add a New User
- Edit User Details
- Delete a User
- Refresh User Page
- Sort User Details
- Filter User Details

Figure 36 - Users Page

The Role determines the type of access assigned to the user.

<table>
<thead>
<tr>
<th>Role</th>
<th>Access Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reader</td>
<td>Read-only</td>
</tr>
<tr>
<td>Contributors</td>
<td>Read and Write</td>
</tr>
<tr>
<td>Administrators</td>
<td>Unlimited</td>
</tr>
</tbody>
</table>

Add a New User

1. Click Add at the top of the Users page.
2. Complete user information in the User Details window:
   - Enter the user's Name.
   - Enter a Password and reenter it in Confirm Password.
   - Enter the Email address to be used for system notifications.
- Select the **Role** to be assigned to the user.

3. Click **Save**. A status message confirms the addition.

*Figure 37 - User Details*

![User Details Form]

**Edit User Details**

1. Select the User from the Users list.

*Figure 38 - Select User*

![Select User List]
2. Click **Edit**.
3. Modify information in the *User Details* window. All fields except **Name** may be modified.

*Figure 39 - Edit User Details*

![User Details](image)

4. Click **Save**.

**Delete a User**

1. Select the User to be removed.
2. Click **Delete**.
3. When prompted, click **OK** to confirm deletion.

*Figure 40 - Confirm Delete User*

![Confirmation](image)

**Refresh User Page**

Click the **Refresh** icon at the top of the page to refresh the User list.

**Sort User Details**

Click on a column heading to sort the User list by that column.
Filter User Details
1. Click the funnel icon beside a column heading.
2. Select filter details from the pop-up window.
   • In the example below, User details are filtered by Contributor Role.
3. Click Filter.

*Figure 41 - Filter By Role*

4. Select Clear Filter to remove the filter.
Variables

Variables can be employed to store metadata information. Default Variables are provided with Adlib PDF.

- Additional Variables may be defined if required. For example, if you would like to configure Job Acceptance Rules to only accept documents with the value “Accepted” in the custom property Approval State, a new Variable “Approval” can be defined for use in the Rule settings.

By default, the Variables page lists Variables by Rule Set Type. Variable usage is displayed by expanding Variable details.

Figure 42 - Rule Set Type Variables
Global Variables may be selected and usage details for each may be displayed by expanding Variable details.

**Figure 43 - Global Variables**

The following options are available:

- **View Variable Usage**
- **Define New Variable Usage**
- **Edit Variable Usage**
- **Delete Variable Usage**

**Variable Options**

**View Variable Usage**

1. Click the plus sign beside a Variable to expand usage details.
2. Select the appropriate tab to list Variables Submitted or Variables Consumed.

Refer to Using Metadata for detailed descriptions of Submitted and Consumed terminology.
Define New Variable Usage
1. Select a Variable in the list.
2. Click New Variable Usage.
3. Enter usage details in the Add / Edit Usage window and click Save.

Edit Variable Usage
1. Select a Variable in the list.
2. Click Edit Usage.
3. Update usage details in the Add / Edit Usage window and click Save.

Delete Variable Usage
1. Select a Variable in the list.
2. Click Delete Usage.
3. When prompted, click OK to confirm deletion.
**Licensing**

The Licensing Page displays the license(s) associated with the Adlib PDF system. Licenses are grouped by feature; each group includes a list of all servers that contain those features. If applicable, the Software Maintenance Plan expiry date is shown in the page heading. If more than one Maintenance Plan has been purchased, the date of the Plan to expire first will be displayed.

*Figure 45 - Licensing Page*

To view the License Key installed on a particular server within a feature group, expand the server list. If the License Key has an expiry date (e.g. an Evaluation License), it is listed in the table.

*Figure 46 - License Information Displayed by Server*
Job Settings

Overview
Job Settings provide configuration functions for defining job processing Instruction Sets. This includes managing job acceptance criteria and defining Rules and Variables required for the configuration and transformation of content. Use Job Settings functions to:

- Define Instruction Sets and assign Sources.
- Optionally, define Local Variables.

Job Settings Page
The Job Settings tab, accessed from the System Settings page, displays a toolbox of Unassigned Sources on the left and a work area where Instructions Sets are configured on the right. Defined Instruction Sets are displayed in the work area. Within the Instruction Set box, a drop zone identifies the area where Sources are assigned.

Figure 47 - Job Settings page
Instruction Sets are groups of job processing Rule Sets that are evaluated on a per job basis when documents arrive in an associated Source. Each Instruction Set is associated to one or more Sources and are configured with Job Acceptance and Transformation Rule Sets.

- **Job Acceptance Rules** define the criteria used to determine if documents are accepted for processing.
- **Transformation Rules** define conversion Settings used to configure how documents are transformed.

**To Define a New Instruction Set.**
1. On the Job Settings page, click **New Instruction Set**.
2. When prompted, type the Instruction Set **Name** and optional **Description** in the Properties window.

*Figure 48 - Instruction Set Properties*

3. The new Instruction Set is displayed in the work area.

*Figure 49 - New Instruction Set*
4. Assign one or more Sources to the Instruction Set.
   - Drag an Unassigned Source from the toolbox to the Instruction Set’s drop zone.

Figure 50 - Drag-and-Drop Source

↓ To Unassign a Source
Removing a Source Component terminates the association with the Instruction Set, however, the Source remains available.

- Drag the Source from the work area to the toolbox.

*Only Sources with NO assigned Components (e.g. Connectors) may be unassigned from an Instruction Set.*

The Action menu in the Instruction Set’s work area provides the following options:

- View Instruction Set Properties
- Delete an Instruction Set
- Export an Instruction Set
- Import an Instruction Set
- Publish an Instruction Set

Figure 51 - Instruction Set Action Menu
Instruction Set Options

Search Instruction Set Names

Enter a full or partial Instruction Set name in the Search box and press Enter. Search results are displayed in the work area below. Click the X in the Search box to clear the search and re-display the page.

Figure 52 - Instruction Set Search box

View Instruction Set Properties

Select Properties to view or update the Instruction Set Name or Description in the Instruction Set Properties window.

Delete an Instruction Set

Only Instruction Sets with NO assigned Sources may be deleted.
1. Select Delete from the Action menu.
2. When prompted, click OK to confirm deletion. A status message confirms successful deletion.
**Export an Instruction Set**

Export the Instruction Set to a file, for reuse in another Instruction Set.

Instruction Sets in either Edit or Active mode may be exported.

1. Select **Export** from the Action menu.
2. In the *Export Instruction Set* window, select the **Rule Set Types** to be exported or **Select All**.
3. Click the ellipsis button to define the export file name and location.
4. Click **Export**. A status message confirms if the export was successful.

*Figure 53 - Export Instruction Set*
**Import an Instruction Set**

Import an Instruction Set from a previously exported file. Any existing rules will be over-written by the imported Instruction Set.

Files may only be imported to Instruction Sets that are in Edit mode.

1. On the **Edit** tab of the *Rule Set Editor* page, select **Import** from the Instruction Set’s Action menu.
2. When prompted, browse to the saved Instruction Set file and click **Open**.
3. In the *Import Instruction Set* window, select to import the Instruction Set Settings from either the **Active** or **Edit** state.
4. Select the **Rule Set Types** to be imported.
5. Click **Import**. A status message confirms if the import was successful.

*Figure 54 - Import Instruction Set*

---

6. To view the imported Settings,
   - Select the Rule Set Type from the Instruction Set’s Setting menu,
   - Navigate to the **Edit** tab of the *Rule Set Editor* page,
   - The Rule Set will be updated with the imported Settings.
**Publish an Instruction Set**

Publishing an Instruction Set places all related Rule Sets into Active mode and enables the Instruction Set for processing.

A green caution indicator identifies Instruction Sets with unpublished changes.

*Figure 55 - Unpublished Indicator*

- Select **Publish** from the Instruction Set’s Action menu or click the caution indicator.

*Figure 56 - Publish Instruction Set*

- A status message confirms that publication was successful.

Published Instruction Sets are displayed in the **Active** tab of the *Rule Set Editor* page as view only. Published Rule Sets may only be edited under the Edit tab and then must be re-published as a new version. Editing done under the *Edit* tab does not affect published Settings.
Rule Sets

Once Instruction Sets are defined and Sources assigned, Job Acceptance and Transformation Rule Sets may be accessed using the Configure Menu on the Job Settings page.

To Define Rule Sets

1. On the Job Settings page, click the Configure down arrow to open the Configure Menu.
2. Select the type of Rules to be defined (Job Acceptance or Transformation) from the drop-down list.

3. The Rule Set Editor page is displayed providing Settings specific to the Rule type selected.

   Record locking prevents multiple users from editing the same Rule Set at the same time.

Rule Set Editor

The Rule Sets Editor page displays a toolbox of Rules and Settings on the left and a work area, where Rule Sets are configured, on the right. Defined Rule Sets are displayed in the work area:

- The Active tab (opens by default) displays published Rule Sets. Active Rule Sets may be viewed but are locked from editing.
- The Edit tab is used to create or modify Rule Sets that are inactive.

Drag a Rule from the toolbox to the rule drop zone. Drag a setting from the toolbox to the setting drop zone. Edit Menus provide options to configure Rules and settings.
The toolbox on the Rule Set Editor page contains the Rules and Settings that can be used to configure Rule Sets. The toolbox lists available Settings specific to the type of Rule Set being defined:

- **Job Acceptance Rule Sets** define criteria that constitutes acceptance or denial of a job based on metadata values.
- **Transformation Rule Sets** define conversion Settings for the job.

Dragging an item from the toolbox to the work area simply takes a copy of the Rule or Setting, working much the same way as a template.

**Settings Search**

To search for a Rule Setting, enter a full or partial Setting name in the Search box and press Enter. Search results are displayed in the work area below. Click the X in the Search box to clear the search and re-display the page.

*Figure 59 - Settings Search box*
To Define Rule Conditions and Settings

1. On the Rule Set Editor page, drag a Rule from the toolbox to the rule drop zone.
   - Use the Rule Edit menu to configure a Rule.
   - Multiple Rules may be included in each Rule Set.

2. Drag a Setting from the toolbox to the setting drop zone.
   - Some Settings may only be used once for each Rule.

3. Use Edit menus to configure Rules and Settings that make up a Rule Set.

TIP Components can be dragged from one Rule Set to another to change linkage (connections).

Rule Conditions

Rule Conditions are user-defined specifications used to determine if a Rule Setting should be applied to a particular input. By default, the Rule Condition associated with every Job Acceptance or Transformation Rule Setting is "true", meaning that the Rule Setting will always be evaluated; however this default setting can be changed. A Rule Condition can be configured to apply the Rule Setting only if certain conditions are met, such as whether a particular template was used to create the document, or if the content was submitted from a particular Source input repository. A Rule Condition can also be used to stop the processing of additional rules once the associated Rule Setting(s) has been applied with the use of an "Exit Flag".

Figure 60 - Rule Conditions Window
**Default Rules**
By default, Always Evaluate To True is checked, indicating that this is a Default Rule.
"Default Rules should only contain attributes that need to be set for ALL jobs, regardless of metadata values.
"Default Rules always evaluate to True. Locate these rules at the bottom of the Rules list so they are only evaluated if ALL other Rules evaluate to False with no Exit Flags.
"For all other Rules, clear the check mark and define the conditions under the Design tab.

**Exit Flags**
By default, Do not process subsequent Rules if this Rule Condition evaluates to is not checked.
"To set an Exit Flag, check this field and select either True or False from the dropdown list.
"Exit Flags stop the processing of Rules when a Rule Condition occurs and are primarily used to stop processing when a Rule is encountered that rejects the job.
For example, if you wanted to create a set of transformations rules that would only apply when a specific document template is used, an Exit Flag could be set that would stop the processing of additional rules once those rules have been applied. In this way you can ensure that other, more general rules will not be applied when multiple types of content is submitted through the same Source.

**Compounding**
Rule Conditions can also be compounded using the AND/OR operator.
"Use AND if both Rule Conditions must be met, or
"Use OR if one of the Rule Conditions must be met
Proper utilization of compounded conditions can help reduce the number of rules required to achieve the desired results. For example, rather than creating individual rules to apply PDF security to a number of different file types, the same result could be achieved with one rule and multiple "OR" conditions for each file type.
If you need to specify AND + OR conditions in the same statement, you should use brackets to explicitly control the outcome using the Source tab on the Rule Condition window. For example, both conditions to be used to create a rule condition in which the associated rule setting(s) would only be applied if the input file was based on a certain document template OR if the file name contains certain information AND if the input came from a specific Source.
For more information on creating rule sets with nested equations, contact Adlib.
Job Acceptance Rules

Job Acceptance Rules define whether jobs are accepted or denied based on metadata values. The **Job Acceptance Rule Set** includes, but is not limited to, the following Settings:

<table>
<thead>
<tr>
<th>Job Acceptance Setting</th>
<th>Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accepted</td>
<td>A True / False Setting to accept or reject the job.</td>
</tr>
<tr>
<td></td>
<td>If this Setting is not present, it is automatically defined as “True”.</td>
</tr>
<tr>
<td>Group Name</td>
<td>Identifies the Group to which the job is assigned.</td>
</tr>
<tr>
<td></td>
<td>Transformation Engines can be configured to only process jobs from specific Groups.</td>
</tr>
<tr>
<td>Names</td>
<td>Explicitly defines the names of the document properties included in the job.</td>
</tr>
<tr>
<td></td>
<td>• “All” instructs the System Manager to read all properties from a document and include each as metadata name/value pairs for the job.</td>
</tr>
<tr>
<td>Priority</td>
<td>Determines the order in which the Transformation Engine will process the job.</td>
</tr>
<tr>
<td>Rendition Type</td>
<td>The rendition type to set (e.g. pdf, html) when adding the job back into Documentum. The default value is pdf.</td>
</tr>
<tr>
<td></td>
<td>This value must be entered in lowercase.</td>
</tr>
</tbody>
</table>

**To Define Job Acceptance Rules**

1. On the *Rule Set Editor* page, drag a Rule from the *toolbox* to the *rule drop zone*.

*Figure 61 - Drag & Drop Job Acceptance Rule*
2. Select **Edit** from the Edit drop-down menu.

   *Figure 62 - Rule Edit Menu*

   ![Rule Edit Menu](image)

3. Define the Rule in the **Edit Rule Condition** window.
   - Type a **Rule Name** and optional **Description**.

   *Figure 63 - Edit Job Acceptance Rule*

   ![Edit Rule Condition](image)

   - By default **Always Evaluate To True** is checked, indicating that this is a **Default Rule**. Default Rules contain settings which need to be set for ALL jobs and are, therefore, located at the bottom of the Rules list. For all other Rules, clear the check mark and define Conditions under the **Design** tab.

   - By default, **Do not process subsequent Rules if this Rule Condition evaluates to** is not checked. To set an **Exit Flag**, check this field and select either **True** or **False** from the drop-down list. Exit Flags stop the processing of Rules when a Rule Condition occurs and are primarily used to stop processing when a Rule is encountered that rejects the job.

   - Click **OK** to return to the **Rule Set Editor**.
4. Assign Settings to the Rule:
   - Drag a Setting from the toolbox to the setting drop zone.

*Figure 64 - Assign Job Acceptance Setting*

5. Select Edit from the Setting’s Edit drop-down menu.

*Figure 65 - Job Acceptance Setting Edit Menu*

6. Define Setting attributes in the Attribute window.
   - Type an Attribute Name, optional Description, and Value. *In this example, a Names Setting is defined.*

*Figure 66 - Edit Job Acceptance Setting*

7. Click OK to return to the Rule Set Editor.
8. Repeat the above steps to configure additional Rules and Settings, as required.

*Figure 67 - Job Acceptance Rule Set*

9. Click **Save** on the *Rule Set Editor* page to save this Job Acceptance Rule Set.
   - A status message confirms if the save was successful.

10. A warning indicator on the *Job Settings* page identifies these changes as unpublished. Publishing is necessary to activate the Rules. To publish the rules, click the warning indicator.

*Figure 68 - Instruction Set Unpublished*
Transformation Rules

Adlib PDF provides many Transformation Rule Settings that can be used to specify how files are to be rendered during content transformation. If desired, a user can first specify a Rule Condition that will determine if the associated Rule Setting(s) will be applied to the input file. Multiple Rule Settings can be associated with a given Rule Condition. Each Rule Setting contains various elements such as margin size, image compression rate, etc., that can defined by the user in order to produce the desired output.

Content Transformation Viewers

During content rendering, the Transformation Engine uses a “viewer” to open a file in preparation for transformation to the specified format. There are 3 types of viewers used by Adlib PDF: native application viewers (e.g. Microsoft Word), Adlib file-type viewers, and a Generic viewer. Each viewer is used to render specific file types; viewers are automatically selected by the Transformation Engine during job processing based on file header and/or extension information.

If desired, viewers can be configured to apply specific defaults (such as image compression settings or font embedding) to the transformation of documents through the use of viewer or file type-specific Rule Settings. Although not strictly necessary for Native Application file processing, these settings provide more precise control of document rendering attributes.

Important: In order to process file types that are not associated with a Native Application or the Adlib viewer type, the Generic viewer Rule Setting must be part of the Instruction Set used to render the file.

Please refer to the Content Transformation Viewers and Supported File Types Appendix in this Guide to determine which viewer is required for the file type you wish to process.

Rule Settings Syntax

The syntax of the Transformation Rule Settings generally follows these formats:

Convert to File Type. Name of Native Application Viewer
- This type of Rule Setting names an output file type and specifies a native application to use in rendering. These Rule Settings allow the user to configure attributes that are specific to the type of document created by the native application. Examples include “ConvertToPdf.MicrosoftExcel” and “ConvertToHtml.MicrosoftPowerPointExport”.

Convert to File Type. Name of Non-Native Application Viewer
- Currently, the only Rule Setting to fit this syntax is the “ConvertToPdf.Generic” Setting, which enables the user to control embedded fonts and image compression and resolution for file types that are rendered using the Generic viewer. It must be included in the Instruction Set in order to enable the processing of files of this type.

Convert to File Type. Input File Type
- These input and output file combinations are always rendered with a built-in Adlib viewer. Examples of this syntax include the setting “ConvertToPdf.Ocr”, which can be used to convert the input OCR files to PDF using the Adlib OCR viewer. A list of supported OCR input file types can be found in the Content Transformation Viewers and Supported File Types Appendix.

PDF Processing. Rule Setting
- These Rule Settings do not specify native application viewers or input file types, but rather identify the type of transformation design elements contained within the Rule Setting.
- For example, the Setting "PdfProcessing.Header" enables the user to specify the text, orientation, font, and page location(s) of the header that is applied once the input file has been rendered to PDF.

A description of the Rule Setting, including which viewer will be used to render the document, or which input or output file is associated with the Setting, is displayed when the mouse is held over the Rule Setting in the left banner.

*Figure 69 - Rule Setting Descriptions*
To Define Transformation Rules

1. On the Rule Set Editor page, drag a Rule from the toolbox to the rule drop zone.

Figure 70 - Drag & Drop Transformation Rule

2. Select Edit from the Edit drop-down menu.

Figure 71 - Rule Edit Menu
3. Define Rule Condition attributes in the *Edit Rule Condition* window.

- Type a **Rule Name** and optional **Description**.

*Figure 72 - Edit Transformation Rule*

- By default **Always Evaluate To True** is checked, indicating that this is a **Default Rule**. Default Rules contain settings which need to be set for ALL jobs and are, therefore, located at the bottom of the Rules list. For all other Rules, clear the check mark and define Conditions under the **Design** tab.

- By default, **Do not process subsequent Rules if this Rule Condition evaluates to** is not checked. To set an **Exit Flag**, check this field and select either **True** or **False** from the drop-down list. Exit Flags stop the processing of Rules when a Rule Condition occurs and are primarily used to stop processing when a Rule is encountered that rejects the job.
- Click **Metadata** and select Variables and Values from the *Metadata Selector* window.

*Figure 73 - Metadata Selector*

- Select a comparison operator from the drop-down list.
- Select a metadata value for comparison.

Refer to *Using Metadata* for detailed information on Metadata selection.
4. To add another condition to the Rule, click **Add** and select a condition operator:
   - Click **AND** if both Rule Conditions must be met, or
   - Click **OR** if one of the Rule Conditions must be met.

*Figure 74 - Add Rule Condition*

To remove a condition, click the **X** beside **Metadata**.
5. To view the XML code created for the Rule, click the Source tab.

Figure 75 - Rule Source

Although some users may require the flexibility of editing their Settings through XML code, Adlib strongly recommends limiting this practice as direct modification of XML code can be difficult to troubleshoot and maintain.

Contact Adlib Services for assistance in editing your settings through XML code.
6. Assign Settings to the Rule:
   - Drag a Setting from the toolbox to the setting drop zone.

  *Figure 76 - Assign Transformation Setting*

7. Select **Edit** from the Setting’s Edit drop-down menu.

  *Figure 77 - Transformation Setting Edit Menu*

8. Define the Setting attributes in the **Attribute** window.
   - Type an **Attribute Name** and optional **Description**.
   - Under the **Design** tab, select details as required for the Attribute selected:
     - Click the green up or down arrow to collapse or expand attribute details.
     - Click **Metadata** to select Variables and values from the **Metadata Selector** window.
     - Click **Use Default** to revert to default values.
Figure 78 - Setting Attributes Window
9. To view the XML code created for the Attribute, click the Source tab.

*Figure 79 - Settings Source*

![XML code screenshot]

**Warning:** Although some users may require the flexibility of editing their Settings through XML code, Adlib strongly recommends limiting this practice as direct modification of XML code can be difficult to troubleshoot and maintain.

**Contact Adlib** Services for assistance in editing your settings through XML code.

10. Click **OK** to return to the Rule Set Editor.

11. Repeat the above steps to configure additional Rules and Settings, as required.
12. Click **Save** on the *Rule Set Editor* page to save this Transformation Rule Set.
   - A status message confirms if the save was successful.

13. A warning indicator on the *Job Settings* page identifies these changes as unpublished. Publishing is necessary to activate the Rules. To publish the rules, click the warning indicator.
Local Variables
Rule Sets can employ multiple Variables. Default Variables are provided with Adlib PDF, however additional Variables may be defined.

To Define a Variable
1. On the Rule Set Editor page, click Add beside Local Variables.

Figure 82 - Add Variable

2. Define the Variable in the Variable Details window.
   - Type a Variable Name and optional Description.
   - Select a Data Type from the drop-down list.
   - Type the Value of the Variable.
   - Click Save to return to the Rule Set Editor.

Figure 83 - Variable Details

3. The variable is added to the Local Variables list.

Figure 84 - Variables List.
- Click the **pencil** icon to edit Variable details.
- Click the **X** to remove the Variable. When prompted, click **OK** to confirm deletion.

Use Variables when defining Settings, the same way as Metadata Variables are used.
Job Setting Samples
This section identifies the steps required for common Job Setting configurations. Use the procedures outlined below for reference purposes.

Procedure One - Add a Header
This procedure illustrates how to add a header to a converted Source document.

1. Navigate to the Source tab under System Settings.
2. Create a Folder Source (if required):
   - Drag Folder from the Source Types toolbox to the drop zone in the work area.
   - Enter the Name “Folder Source” in the Properties window.
   - Select Edit from the Edit drop-down menu.
   - In the Input field, type the location of the input folder.
   - In the Output field, type the location of the output folder.
   - Click the Connectors plus sign and select Folder Connector from the drop-down list.
   - Click Save.
   - Publish the Environment.
3. Navigate to Job Settings. The Folder Source you just created should appear in the Unassigned Sources toolbox.
4. Create a Header Instruction Set:
   - Click New Instruction Set.
   - Enter the Name “Header” in the Properties window and click Save.
   - Drag Folder Source from the toolbox to the drop zone for the Header Instruction Set you just created.
5. Create Header Transformation Rule:
   - Select Transformation Rules from the Settings menu of the Header Instruction Set.
   - On the Rule Set Editor page, drag the Rule from the toolbox to the rule drop zone.
6. Configure Header Setting:
   - Drag the PDF Processing Header Setting from the toolbox to the setting drop zone.
   - Edit the Header Setting.
   - In the Job.Header attribute window, type a Name and configure attributes as required. The illustration below displays sample Settings.

   To revert to default values, click Use Default beside the Setting field.
   - Click OK to return to the Rule Set Editor.
7. **Save** the Instruction Set.
8. Navigate to Job Settings.
9. Select **Publish** from the Instruction Set’s Edit menu.

These processing instructions are now active and ready to process a Source document.

**Procedure Two - Enable Optical Character Recognition (OCR)**

This procedure illustrates how to create a searchable PDF using OCR.

- Adlib’s Optical Character Recognition (OCR) capabilities recognizes textual information in scanned documents and renders documents in a text-searchable PDF format.

1. Navigate to the **Source** tab under **System Settings**.
2. Create a Folder Source (if required):
   - Drag **Folder** from the **Source Types toolbox** to the **drop zone** in the **work area**.
   - Enter the **Name** “Folder Source” in the **Properties** window.
   - Select **Edit** from the Edit drop-down menu.
   - In the **Input** field, type the location of the input folder.
   - In the **Output** field, type the location of the output folder.
   - Click the Connectors plus sign and select **Folder Connector** from the drop-down list.
   - Click **Save**.
   - **Publish** the Environment.
3. Navigate to Job Settings. The **Folder Source** you just created should appear in the **Unassigned Sources toolbox**.

4. Create an OCR Instruction Set:
   - Click **New Instruction Set**.
   - Enter the **Name** "OCR" in the Properties window and click **Save**.
   - Drag **Folder Source** from the **toolbox** to the **drop zone** for the OCR Instruction Set you just created.

5. Create OCR Transformation Rule:
   - Select **Transformation Rules** from the **Settings** menu of the OCR Instruction Set.
   - On the **Rule Set Editor** page, drag the **Rule** from the **toolbox** to the **rule drop zone**.

6. Configure OCR Rule Condition:
   - Edit the Rule Condition and enter the **Name** “OCR” in the **Edit Rule Condition** window.

7. Configure OCR Setting:
   - Drag the **Convert to PDF OCR** Setting from the **toolbox** to the **setting drop zone**.

8. Edit the OCR Setting:
   - In the **Job.Header** attribute window, type a **Name** and configure attributes as required.
     In the following example, the job will recognize both English and French text.

     ![OCR Attributes](image)

     To revert to default values, click **Use Default** beside the Setting field.
   - Click **OK** to return to the **Rule Set Editor**.

**Figure 86 - OCR Attributes**

9. **Save** the Instruction Set.
10. Navigate to Job Settings.
11. On the OCR Instruction Set, select Publish from the Action menu.

These processing instructions are now active and ready to process a Source document.

Procedure Three - Use Metadata-Based Rules from the Folder Connector

This procedure illustrates how to create a Rule based on metadata from the Folder Connector. This example will create a Rule to disallow any jobs that are greater than or equal to 5MB in size.

1. Navigate to the Source tab under System Settings.
2. Create a Folder Source (if required):
   - Drag Folder from the Source Types toolbox to the drop zone in the work area.
   - Enter the Name “Folder Source” in the Properties window.
   - Select Edit from the Edit drop-down menu.
   - In the Input field, type the location of the input folder.
   - In the Output field, type the location of the output folder.
   - Click the Connectors plus sign and select Folder Connector from the drop-down list.
   - Click Save.
3. Navigate to Job Settings. The Folder Source you just created should appear in the Unassigned Sources toolbox.
4. Create a Metadata Instruction Set:
   - Click New Instruction Set.
   - Enter the Name “Metadata” in the Properties window and click Save.
   - Drag Folder Source from the toolbox to the drop zone for the Metadata Instruction Set you just created.
5. Create Metadata Job Acceptance Rule:
   - Select Job Acceptance Rules from the Settings menu of the Metadata Instruction Set.

   Tip: To use default Settings already available in Adlib PDF, disregard the first four steps and create this Job Acceptance Rule for the Default Instruction Set.

   - On the Rule Set Editor page, drag a Rule from the toolbox to the rule drop zone.
6. Configure Metadata Rule:
   - Edit the Rule and enter the Name “Metadata” in the Edit Rule Condition window.
   - Deselect Always Evaluate To True.
   - Click Metadata beside the first field.
   - In the Metadata Selector window:
     - Expand Variables Submitted with Jobs.
     - Expand Folder Connector.
- Click **Insert Selection**.
  - The condition selected is returned to the *Edit Rule Condition* window.
  - Click the **Equals** operator and select **>= Is Greater than or Equals** from the dropdown list.
  - In the second field, enter “5242880” (*this equates to 5MB*).
  - Click **OK**.

7. In the *Rule Set Editor* page, drag **Accepted** from the Setting toolbox to the *setting drop zone*.
8. **Edit** the Accepted Setting.
9. In the *Edit Attribute* window, enter “false” in the **Value** field. Click **OK**.
10. Click **Save** on the *Rule Set Editor* page to save the Instruction Set.
11. Navigate to the *Job Settings* page.
12. Select **Publish** from the Instruction Set’s Action menu.
    
Any files greater than or equal to 5MB will fail, all others will process normally.

*Figure 87 - Published Metadata Instruction Set*
Monitoring

Overview
Adlib PDF provides a reporting mechanism for Component health monitoring, troubleshooting, system and job logging, and performance reporting. Job and system information is collected in a central database to capture vital system statistics and facilitate reporting. This information can be used to monitor system loads, verify that system performance meets Service Level Agreements (SLAs), and anticipate the need to expand capacity before users or business performance is affected.

Four tabs are available:
- **Job Status** provides information on submitted jobs
- **System Status** identifies the health status of Components
- **System Log** displays logs of events (e.g. Component Initialization, job details, health monitoring, etc.)
- **Reporting Page** lists reports to provide statistics on job and system health

*Figure 88 - Monitoring Page*

Once data has been extracted from the database and is displayed on the page, the following options are used to manipulate data on *Monitoring* pages:
- **Sort Page Details**
- **Filter Page Details**
- **Search Page Details**
- **Group Page Details**
- **Review Log Details**
Monitoring Page Options

Sort Page Details

1. Click on any column header.
2. Page details are sorted in ascending order by that column. Click on the column header again to re-sort in descending order. Click on the column header a third time to clear the sort order.
   - In the example below, System Status details are sorted by Component Type.

Figure 89 - Sorted Details
**Filter Page Details**

Use the Filter function to display only those records that match specified values.

1. Click the filter icon beside a column header.
2. In the *Filter* pop up window,
   - Check one or more of the values listed to immediately filter details or
   - Enter criteria and operator values and click *Filter*.
   - *The example below illustrates the filter for the Component Status column on the System Status page.*

*Figure 90 - Filter pop up*
3. Page details are refreshed with only those records that match the selected criteria.
   - In this example, the System Status page is refreshed to only display records with Started Component Status, as selected in the filter.

Figure 91 - Filtered Details

4. Click Clear Filter to remove the filter and refresh the page.

5. Alternatively, expand the Filter area at the top of the page, enter the desired filter criteria and click the Run Query button. The query results are displayed in the grid portion of the page. Click the Filter Reset button to clear the filter fields. The Filter Applied message indicates that the search results are currently filtered.

Figure 92 - Filter Criteria
**Search Page Details**

Use the Search function to search for records with a specific value.

1. In the **Search** box, at the top of the page, enter a search value.

   The search is automatically applied as each keystroke is entered in the **Search** box.

2. Page details are refreshed with only those records that contain the search text.
   - *The example below illustrates search results for “context.txt” on the Job Status page.*

   **Figure 93 - Search Results**

3. Click the X in the **Search** box to clear the search and re-display the page.

**Group Page Details**

Use the Group function to group log details by specific columns.

1. Drag a column header to **Grouped By**.

   **Figure 94 - In this example, the column header Component Type is dragged to the group area**
Log details are grouped by the column selected.

Figure 95 - This example illustrates the same log details as above grouped by Component Type.

2. Drag multiple columns to enable sub-grouping.
   - Log details are grouped by the first group column selected. Within that group, details are grouped by the next column selected.

Figure 96 - In this example, log details are grouped first by Component Status and then by Component Type.
3. Click the X in a column name in the *group area* to remove grouping by that column.

*Figure 97 - Grouped By*

| Grouped by: | Component Type | Component Status |

**↓ Review Log Details**

Log details may extend to multiple pages.

- The current page number and total number of records retrieved are displayed at the bottom right of the page.
- Use the page selector, displayed at the bottom left of the page, to select the first, previous, next or last page of log details.
Job Status

Job Status provides detailed information about each job submitted and uses this information to troubleshoot in the event that a document fails to be converted.

The Job Status page, accessed from the Monitoring tab, provides a search criteria area where search details are defined and an execute search arrow to query the database for job information based on criteria specified. Search results are displayed in the grid portion of the page. To reset the filter criteria, click the Reset button to the left of the Execute Search arrow.

Figure 98 - Job Status Page

- An Export option is available to export Job Status to Excel spreadsheet format.
- A Problem Submission option collects information about selected jobs and packages it into a file that can be submitted to Adlib Support to expedite issue resolution.
- The Job Id parameter provides a link to System Log entries related to that job. This is used to determine whether a system Component was the reason that a Job Id did not successfully complete.
To Search Jobs

1. Click the Search Criteria Filter down-arrow at the top of the Job Status page.

2. Enter the Start Date and End Date, or click the calendar icon and select dates from the calendar pop-up.

Figure 99 - Search Calendar

3. Enter additional search criteria, as required:
   - Job Id,
   - Document Name,
   - Source, selected from a drop-down list,
   - Job Status, selected from a drop-down list.

4. Drag the # Records to Return slider to limit the number of records returned in the search results.

Figure 100 - Search Criteria

5. Click the green arrow to execute the query based on search criteria. Search results are displayed. Click the Reset button to the left of the Execute Search arrow to reset the filter criteria.
Job Status Page

Job Status lists all jobs meeting the criteria selected. For each job, the following details are displayed:

<table>
<thead>
<tr>
<th>Job Status Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completed On</td>
<td>Date and time when job completed.</td>
</tr>
<tr>
<td>Environment Name</td>
<td>Name of Environment to which the Component is assigned.</td>
</tr>
<tr>
<td>Job Id</td>
<td>Unique identification assigned to each job. Links to System Log page with log entries filtered for this Job Id only.</td>
</tr>
<tr>
<td>Priority</td>
<td>Run priority assigned to the job, where 1 is the highest priority and will be run before other jobs with a lower priority.</td>
</tr>
<tr>
<td>Started On</td>
<td>Date and time when job started.</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates status of job, as:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Uninitialized</strong> - job has been requested but not yet accepted by the system.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Initialized</strong> - job has been accepted by the system and processing is pending.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Committed</strong> - job is committed and ready for processing.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Ready</strong> - the job ticket has been generated and the job has been queued for processing.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Processing</strong> - the Transformation Engine is currently processing the job.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Completed Successful</strong> - job executed successfully from end to end.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Completed Failed</strong> - a failure occurred at some point during job execution that caused the job to fail.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Completed / Resubmission Failed</strong> - where configured, jobs may be resubmitted by the Job Manager if they fail. After a specified number of failed tries, the job is flagged with this status.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Completed Cancelled</strong> - a request was made to cancel the job, and it was successfully cancelled.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Completed Uncommitted</strong> - either the job failed before it reached the committed state or the job was submitted but not committed by the user.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Completed JAR Rejected</strong> - the job was rejected by the Job Acceptance Rules (JAR) applicable to that job.</td>
</tr>
<tr>
<td>Updated On</td>
<td>Date and time of last heartbeat update.</td>
</tr>
</tbody>
</table>

Job Status Details

Click the plus sign beside a job row to expand Job Status details, listed under four tabs:

*Figure 101 - Job Status Details*
Component Tab

The Component tab provides details on the Submitter (typically, the Connector that submitted the job), System Manager and Transformation Engine Components.

<table>
<thead>
<tr>
<th>Job Status Component Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submitter Component Type</td>
<td>Category to which the Submitter Component belongs.</td>
</tr>
<tr>
<td>Submitter Install Path</td>
<td>Location where the Submitter Component is installed.</td>
</tr>
<tr>
<td>Submitter Machine Name</td>
<td>Machine on which the Submitter Component resides.</td>
</tr>
<tr>
<td>System Manager Install Path</td>
<td>Location where the System Manager Component is installed.</td>
</tr>
<tr>
<td>System Manager Machine Name</td>
<td>Machine on which the System Manager Component resides.</td>
</tr>
<tr>
<td>Engine Install Path</td>
<td>Location where the Engine Component is installed.</td>
</tr>
<tr>
<td>Engine Machine Name</td>
<td>Machine on which the Engine Component resides.</td>
</tr>
</tbody>
</table>

Job Tab

The Job tab provides details on how the job flowed through the system. It identifies, for example, the Rules that were executed to create the job.

Figure 102 - Job Tab

Click the Job Processing button to view the Job Processing log in an XML Visualizer in either Treeview or Source format.

The Details Window can be enlarged by dragging the green triangle in the bottom right corner of the window. Right-click an item in the treeview for more options such as expand, collapse, or copy.
Click the **Job Ticket** button to view the Job Ticket used by the Transformation Engine to process the job in an XML Visualizer in either **Treeview** or **Source** format. The **Details Window** can also be enlarged by dragging the green triangle in the bottom right corner of the window. A search function is available in the **Source** tab.

**Job Documents**

The **Job Documents** tab identifies the **Document Name(s)** processed in the job.
Engine

The *Engine* tab displays job completion details:

<table>
<thead>
<tr>
<th>Job Status Engine Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engine Start Time</td>
<td>Date and time job started.</td>
</tr>
<tr>
<td>Engine Complete Time</td>
<td>Date and time job completed.</td>
</tr>
<tr>
<td>Job Completion Code</td>
<td>Job completion return code received from the engine.</td>
</tr>
<tr>
<td>Job Completion Description</td>
<td>Job completion return text received from the engine.</td>
</tr>
<tr>
<td>Job Completion Detail</td>
<td>Job information details received from the engine.</td>
</tr>
</tbody>
</table>

**To Link to System Log**

1. Click on a **Job Id** in the *Job Status* page.
2. Adlib PDF navigates directly to the *System Log* filtered to display all records with the selected **Job Id**.

*Figure 105 - Job Id link to System Log*
**To Export Job Status**

Use the Export function to export *Job Status* to Excel spreadsheet format.

1. Click **Export**.
2. When prompted, enter a **File name** and browse to a file location.
3. Click **Save**. A status message confirms if the Export was successful.

*Figure 106 - Job Status Spreadsheet*

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documents</td>
<td>Environment Name</td>
<td>Job Id</td>
<td>Status</td>
</tr>
<tr>
<td>document1,37650447-467c-44d0-a1</td>
<td>My first component test workspace</td>
<td>acbe06947b7-244a4d1d422b3</td>
<td>Completed</td>
</tr>
<tr>
<td>c\documents\context.txt,37650447</td>
<td>My first component test workspace</td>
<td>ef7825588b7-9a4541cb75f0</td>
<td>Uninitialized</td>
</tr>
<tr>
<td>document2,document3,documents</td>
<td>My first component test workspace</td>
<td>61f1f1193515e-84d4c7ed28c6ed</td>
<td>Completed</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**To Create a Job Status Report**

Use the Create Report function to generate an XML report of Job Status.

1. Select **Create Report**.
2. When prompted, enter a **File name** and browse to a file location.
3. Click **Save**. A zip file containing the XML report is generated to the location specified.

*Figure 107 - Job Status Report*
**System Status**

*System Status* identifies the health status, or heartbeat, of all Components in Adlib PDF. Components can be running on various machines across the network.

The *System Status* page, accessed from the *Monitoring* tab, provides an *Alarm Acknowledged* indicator to acknowledge Component status alarms. An *Export* option is available to export *System Status* to Excel spreadsheet format.

*Figure 108 - System Status Page*
**System Status Page**

For each system Component, the **System Status** identifies the following parameters:

<table>
<thead>
<tr>
<th>System Status Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Acknowledged</td>
<td>Indicates user acknowledgement of status alarm. When checked, the alarm on the System Status Overview on the <strong>Home</strong> page stops flashing, signifying acknowledgment.</td>
</tr>
<tr>
<td>Component Status</td>
<td>Indicates status of Component, as:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Faulted</strong> - Component sent fault error</td>
</tr>
<tr>
<td></td>
<td>- <strong>Initialized</strong> - Component is initialized but is not completed starting</td>
</tr>
<tr>
<td></td>
<td>- <strong>Installed</strong> - Component is installed but has never been started</td>
</tr>
<tr>
<td></td>
<td>- <strong>Stalled</strong> - Component has stopped heartbeating</td>
</tr>
<tr>
<td></td>
<td>- <strong>Started</strong> - Component is started and working</td>
</tr>
<tr>
<td></td>
<td>- <strong>Stopped</strong> - Component has been stopped</td>
</tr>
<tr>
<td></td>
<td>- <strong>Uninstalled</strong> - Component has been uninstalled</td>
</tr>
<tr>
<td>Component Type</td>
<td>Identifies the category to which the Component belongs, as:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Documentum Connector</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Folder Connector</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Generic Connector</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Job Management Service</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Process Manager</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Services</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>SharePoint Workflow Connector</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>System Manager</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Transformation Engine</strong></td>
</tr>
<tr>
<td>Environment Name</td>
<td>Environment to which the Component is assigned.</td>
</tr>
<tr>
<td>Install Path</td>
<td>Location where the Component is installed (e.g. C:\Program Files\Adlib&lt;InstallFolder&gt;).</td>
</tr>
<tr>
<td>Log Level</td>
<td>Identifies the type of log message, by level of severity:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Trace</strong> - Highly detailed information that indicates all activities performed by the system as it executes, useful for troubleshooting complex issues.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Debug</strong> - Moderately detailed information of a technical nature, typically useful for troubleshooting the root cause of key issues.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Info</strong> - Provides information on a successful action taken by the system, or on items that may be of interest to the end user. May also provide some error details if a failure occurs.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Warning</strong> - Indicates that a possible issue may exist, but the system was able to continue processing.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Error</strong> - Indicates that an error occurred while processing that prevented the system from continuing the current process; however, the system recovered.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Fatal</strong> - Indicates that an error occurred while processing, from which the system could not recover.</td>
</tr>
<tr>
<td>Machine Name</td>
<td>Machine on which the Component is installed.</td>
</tr>
<tr>
<td>Started On</td>
<td>Date and time when Component started.</td>
</tr>
</tbody>
</table>
Currently, there are two Job Management Service Components installed with Adlib PDF.
One, identified by the version (1.7) and install path (C:\Program Files\Adlib\Web\JobManagementService\bin) is a WCF-based Service for use with a Generic (Custom) Connector. The second, identified by the version (3.7) and path (C:\Program Files\Adlib\Web\DirectorWSA\bin) is used by the other Adlib PDF Connectors. The Component Status of the Job Management Services may appear as “Stalled” if a sizable amount of time passes between jobs, even though the Components remain functional.

**System Status Details**
Click the plus sign beside a Component row to expand System Status details.

*Figure 109 - System Status Details*

<table>
<thead>
<tr>
<th>System Status Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timeout Interval(s)</td>
<td>Interval, in minutes, between heartbeats.</td>
</tr>
<tr>
<td>Updated On</td>
<td>Date and time of last heartbeat update.</td>
</tr>
</tbody>
</table>

- The *Init Data* tab provides Component initialization information. It identifies the Settings the Component used to initialize itself at start up. Incorrect Settings can lead to unexpected system behavior.
Changing Component Log Levels

By default, Adlib PDF is set to "Debug on Error". This is a log setting that will create debug error logs for each job that is processed, but will then remove all the log information below a specified threshold (e.g. Info only) if no errors occur during processing. Information level logs are retained for successful jobs.

In the case where a job completed successfully but still produced unexpected results, it may be useful to temporarily increase the level of logging of successful jobs in order to troubleshoot various aspects of the processing of the job. For more information about changing log levels, see How Do I Change Logging Levels?

To Change Component Log Levels

1. Double-click within the **Log Level** column for the desired Component and select a new log level.

2. Rerun the job and view the modified Job Status log on the Monitoring page.

*Figure 110 - Change Component Log Levels*
To Export System Status

Use the Export function to export System Status to Excel spreadsheet format.

1. Click Export.
2. When prompted, enter a File name and browse to a file location.
3. Click Save. A status message confirms if the Export was successful.

![Figure 111 - System Status Spreadsheet](image)

To Assign a Friendly Name to a Component

Components can be assigned “friendly names” to assist the user in differentiating among multiple components installed on the same machine.

1. Within the Component Name column, click twice on the name of the Component to be changed to enable it for editing.
2. Type the Friendly Name. Repeat as necessary to rename additional Components.
3. Click the Component Name column header to sort by the Component list by name.

![Figure 112 - Assign a Component Friendly Name](image)
**System Status Overview**

The *System Status Overview*, displayed on the *Home* page, visually identifies the health status of Adlib PDF Components. Each box in the *Overview* represents a Component category.

*Figure 113 - System Status Overview*

---

**Connectors**

Connector Components monitor Sources for content. They submit the content as jobs to Adlib PDF and receive completed job output. When these Components are inoperative, new jobs will not be initiated from Sources.

**Services**

This is a layer of WCF-based (Windows Communication Foundation) services used primarily by the Management Console. Job Management Service is a set of web service calls that permit external integration with Adlib PDF.

**System Managers**

System Manager Components manage jobs received via web services and are responsible for monitoring the health of all Components and issuing alerts.

**Engines**

Engine Components perform the transformation of files. When these Components are inoperative, jobs may still be received and queued by the system, but will not be completed until one or more Engines become available.
**Process Managers**

Process Manager Components control individual processes on a single machine within Adlib PDF. There is one Process Manager Component on each machine on which Adlib Components are installed. Process Managers start, stop, monitor and restart the processes assigned to it.

**System Status**

The System Status box identifies the overall status of Adlib PDF. When alarms are issued, this box will be flagged with a warning.

**System Status Component Links**

Clicking on a Component box in the *System Status Overview* opens the *System Status* page, filtered to display status information for the selected Component category.

*Figure 114 - In this example, clicking on the Services box displays the System Status page filtered to show Service Components only.*
Alarms

When an Adlib PDF Component is in an alarm state (e.g. faulted, stalled), it is flagged on the System Status Overview with a flashing warning indicator.

- Clicking on a Component box in the Overview opens the System Status page, filtered to display information about the selected Component.
- When alarms are acknowledged on the System Status page, the warning indicator state changes from flashing to solid.
- Once the issue that caused the alarm is resolved, the warning indicator is no longer displayed in the Overview.

To Acknowledge Alarms

1. On the System Status Overview, click on a Component box that displays a flashing warning indicator.
2. The Adlib application opens the System Status filtered for the Component selected.
   For example, if the System Manager Component box displays a warning indicator, clicking on the box opens the System Status page filtered to display System Manager Components only. Filtering is identified in the breadcrumb trail and through highlighted filter icons on Component Type and Component Status columns.
3. Check the **Alarm Acknowledged** parameter to acknowledge the Component alarm. The state of the warning indicator on the **System Status Overview** changes from flashing to solid.

*Figure 115 - System Status with Alarm Indicators.*

*Figure 116 - System Status Alarm Acknowledged*
System Log

System Log provides event logs from Components within Adlib PDF.

The System Log page, accessed from the Monitoring tab, provides a search criteria area where search details are defined and an Execute Search arrow to query the database for system information based on criteria specified. Search results are displayed in the grid portion of the page.

Click the Filter Reset button to clear the filter fields. The Filter Applied message indicates that the search results are currently filtered.

Figure 117 - System Log Page

- An Export option is available to export System Log to Excel spreadsheet format.
- A Problem Submission option collects information about selected System Log entries and packages it into a file that can be submitted to Adlib Support to expedite issue resolution.
To Search System Log

1. Click the Search Criteria Filter down-arrow at the top of the System Log page.

2. Enter the **Start Date** and **End Date**, or click the **calendar** icon and select dates from the calendar pop-up.

3. Enter additional search criteria, as required:
   - **Job Id**,
   - **Machine Name**, selected from a drop-down list,
   - **Log Level**, selected from a drop-down list,
   - **Document Name**,
   - **Logger Name**, selected from a drop-down list.
   - **Component Name**, selected from a drop-down list.

4. Drag the **# Records to Return** slider to limit the number of records returned in the search results.

5. Click the green arrow to execute the query based on search criteria. Search results are displayed.
System Log Page
For each Adlib PDF event, the System Log identifies the following parameters:

<table>
<thead>
<tr>
<th>System Log Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Context</td>
<td>Name of the document being processed when the event occurred.</td>
</tr>
<tr>
<td>Job Id</td>
<td>Unique identification assigned to each job.</td>
</tr>
<tr>
<td></td>
<td>Links to Job ID on Job Status page.</td>
</tr>
<tr>
<td>Log Level</td>
<td>Identifies the type of log message, by level of severity:</td>
</tr>
<tr>
<td></td>
<td>• Trace - Highly detailed information that indicates all activities performed by the system as it executes, useful for troubleshooting complex issues.</td>
</tr>
<tr>
<td></td>
<td>• Debug - Moderately detailed information of a technical nature, typically useful for troubleshooting the root cause of key issues.</td>
</tr>
<tr>
<td></td>
<td>• Info - Message that provides information on a successful action taken by the system, or on items that may be of interest to the end user.</td>
</tr>
<tr>
<td></td>
<td>• Warning - Message to indicate that a possible issue may exist, but the system was able to continue processing.</td>
</tr>
<tr>
<td></td>
<td>• Error - Message to indicate that an error occurred while processing that prevented the system from continuing the current process; however, the system recovered.</td>
</tr>
<tr>
<td></td>
<td>• Fatal - Message to indicate that an error occurred while processing, from which the system could not recover.</td>
</tr>
<tr>
<td></td>
<td>For more information on changing log levels, see How Do I Change Logging Levels?</td>
</tr>
<tr>
<td>Logger Name</td>
<td>Name assigned to the logger module.</td>
</tr>
<tr>
<td>Machine Name</td>
<td>Name of the machine on which the event occurred.</td>
</tr>
<tr>
<td>Message</td>
<td>Log entry message.</td>
</tr>
<tr>
<td>Occurred On</td>
<td>Date and time when the event occurred.</td>
</tr>
</tbody>
</table>

System Log Details
Click the plus sign beside an event row to display associated information, listed under three tabs:

- The Full Message tab displays the entire log entry.

Figure 120 - System Log Full Message

- The Exception tab displays detailed exception data (if any). Typically for errors only.
- The Stack Trace tab displays the call stack to help technical support identify where in the code the log entry was generated.
To Export System Log

Use the Export function to export the System Log to Excel spreadsheet format.

1. Click Export.
2. When prompted, enter a File name and browse to a file location.
3. Click Save. A status message confirms if the Export was successful.

Figure 121 - System Log Spreadsheet

To Report System Log

Use the Create Report function to generate an XML report of the System Log.

1. Select Create Report.
2. When prompted, enter a File name and browse to a file location.
3. Click Save. A zip file containing the XML report is generated to the location specified.

Figure 122 - System Log Report
Reporting Page
Adlib collects job and system information in a central database to facilitate performance reporting, providing statistics on job and system health.

From the Reporting page, accessed from the Job Settings tab, four reports are available:

- **System Load Report** reports on engine workload
- **Job Success Report** reports the percentage of jobs that completely successfully
- **Job Time Report** reports the processing times for all jobs within a time range
- **Job Volume Report** reports how many jobs the system has processed

Report pages provide a Report Parameters drop down to query the database for job and system data for a specified period and time interval.

- An Export option is available to export a report to Excel spreadsheet format.
- A Search box enables searching of report results. Page numbers and page selection is available at the bottom of the report page.
- Filters are available to filter report results by specified report values.

**To Generate a Report**

1. Click the Report Parameters drop down arrow to open report criteria.

   ![Report Parameters Query](image)

2. Enter the start of the report period in the From UTC date, or select a date from the calendar icon.

3. Enter the end of the report period in the To UTC date, or select a date from the calendar icon.

   Dates and times are represented using coordinated universal time (UTC).

4. If available, select a **Time Interval** from the drop-down list:
   - Select **Hour** to report activity for each hour within the reporting period.
   - Select **Day** to report activity for each day within the reporting period.
   - Select **Week** to report activity for each week within the reporting period.
5. Click the green arrow to execute the query based on report criteria. Report results are displayed.

To Export a Report

Use the Export function to export a Report to Excel spreadsheet format.

1. Click **Export** at the top of the **Report** page.
2. When prompted, enter a **File name** and browse to a file location.
3. Click **Save**. A status message confirms if the Export was successful.

*Figure 124 - Exported Report Spreadsheet*
System Load Report
The System Load reports how often an engine was doing work during a specified period. For each time interval selected, System Load reports the following parameters:

<table>
<thead>
<tr>
<th>System Load Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UTC Date</td>
<td>Date within the reporting period.</td>
</tr>
<tr>
<td>UTC Time</td>
<td>Time within the reporting period, displayed only if Hour Time Interval is selected.</td>
</tr>
<tr>
<td>Average System Load (%)</td>
<td>The average system load for the date / time.</td>
</tr>
<tr>
<td>&lt;Transformation Engine&gt; (%)</td>
<td>For the Transformation Engine specified, the percentage of time that the Engine was in use during the time interval. One column is displayed for each individual Transformation Engine.</td>
</tr>
<tr>
<td>Average Load</td>
<td>The total average load over the reporting period, displayed at the bottom of the report.</td>
</tr>
</tbody>
</table>

Figure 125 - System Load Report
**Job Success Report**

Job Success reports the percentage of jobs that completed successfully during a specified period. For each time interval selected, Job Success reports the following parameters:

<table>
<thead>
<tr>
<th>Job Success Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UTC Date</td>
<td>Date within the reporting period.</td>
</tr>
<tr>
<td>UTC Time</td>
<td>Time within the reporting period, displayed only if Hour Time Interval is selected.</td>
</tr>
<tr>
<td>&lt;Transformation Engine&gt; (%)</td>
<td>For the Transformation Engine specified, the percentage of jobs processed during the time interval that completed successfully. One column is displayed for each individual Transformation Engine.</td>
</tr>
</tbody>
</table>

**Figure 126 - Job Success Report**

![Job Success Report Table](image)
**Job Time Report**

Job Time reports the processing time for all jobs during a specified period. For each time interval selected, Job Time reports the following parameters:

<table>
<thead>
<tr>
<th>Job Time Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UTC Start Time</td>
<td>Date and time the job started.</td>
</tr>
<tr>
<td>Source</td>
<td>Source from which the job originated.</td>
</tr>
<tr>
<td>Job Status</td>
<td>Status of the job.</td>
</tr>
<tr>
<td>Job Duration(s)</td>
<td>Length of time the job took to process.</td>
</tr>
<tr>
<td>Job Id</td>
<td>Unique job identification number.</td>
</tr>
<tr>
<td>Average Job Duration(s)</td>
<td>The average job duration over the entire reporting period, displayed at the bottom of the report.</td>
</tr>
</tbody>
</table>

**Figure 127 - Job Time Report**

![Job Time Report Table](image-url)
**Job Volume Report**

Job Volume reports the number of jobs processed. For each time interval selected, Job Volume reports the following:

<table>
<thead>
<tr>
<th>Job Volume Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UTC Date</td>
<td>Date within the reporting period.</td>
</tr>
<tr>
<td>UTC Time</td>
<td>Time within the reporting period, displayed only if Hour Time Interval is</td>
</tr>
<tr>
<td></td>
<td>selected.</td>
</tr>
<tr>
<td>Total System Volume</td>
<td>Total volume of jobs processed for the time interval.</td>
</tr>
<tr>
<td>&lt;Transformation Engine&gt;</td>
<td>For the Transformation Engine specified, the number of jobs processed by the</td>
</tr>
<tr>
<td></td>
<td>Engine during the time interval.</td>
</tr>
<tr>
<td></td>
<td>One column is displayed for each individual Transformation Engine.</td>
</tr>
<tr>
<td>Total Number of Jobs Processed</td>
<td>Total number of jobs processed during the entire reporting period,</td>
</tr>
<tr>
<td></td>
<td>displayed at the bottom of the report.</td>
</tr>
</tbody>
</table>

**Figure 128 - Job Volume Report**

![Job Volume Report](image-url)
Appendix A: Frequently Asked Questions

Overview
This section provides answers to common questions regarding the configuration and operation of Adlib PDF, including:

- How Do I Structure my Job Processing Rules?
- What Are the Stages of Job Processing?
- How Do I Configure Adlib PDF for High Availability?
- How Do I Find Out Why My Job Failed?
- What Do I Do if a Component is Generating an Alarm?
- Why Can I Not Process Any Jobs?
- How Do I Change Logging Levels?
- How Do I Get Rid of the Input File Extension in the Rendered PDF?
- How Do I Change the Input File Destination After Job Processing?

How Do I Structure my Job Processing Rules?
Adlib PDF provides many Job Acceptance and Transformation Rule Settings that can be used to specify which files should be processed and how those files are to be rendered during content transformation. Each Rule Setting contains various elements such as margin size, image compression rate, etc., that can be configured by the user in order to produce the desired output.

A “rule” consists of two parts: a Rule Condition that determines if the Rule Setting should be applied to the job input, and a Rule Setting, which contains the processing details to be applied to the job. A collection of Job Acceptance and Transformation Rules is built within an Instruction Set. Jobs are directed to a particular Instruction Set through the assignment of one or more Connector Sources, through which content is input to Adlib PDF.

Rule Conditions
Rule Conditions are user-defined specifications used to determine if a Rule Setting should be applied to a particular input. By default, the Rule Condition associated with every Job Acceptance or Transformation Rule Setting is “true”, meaning that the Rule Setting will always be evaluated; however this default setting can be changed. A Rule Condition can be configured to apply the Rule Setting only if certain conditions are met, such as whether a particular template was used to create the document, or if the content was submitted from a particular Source. A Rule Condition can also be used to stop the processing of subsequent rules once the associated Rule Setting(s) has been applied with the use of an “Exit Flag”.

Default Rules

By default, Always Evaluate To True is checked, indicating that this is a Default Rule.

- Default Rules should only contain attributes that need to be set for ALL jobs, regardless of metadata values.
- Default Rules always evaluate to True. Define these rules at the bottom of the Rules list so they are only evaluated if ALL other Rules evaluate to False with no Exit Flags.
- For all other Rules, clear the checkmark and define the conditions under the Design tab.

Exit Flags

By default, Do not process subsequent Rules if this Rule Condition evaluates to is not checked.

- To set an Exit Flag, check this field and select either True or False from the drop-down list.
- Exit Flags stop the processing of Rules when a Rule Condition occurs and are primarily used to stop processing when a Rule is encountered that rejects the job.

For example, to create a set of Transformation Rules that would be used only when a specific document template is used, an Exit Flag could be set that would stop the processing of subsequent rules. In this way you can ensure that other, more general rules will not be applied when multiple types of content are submitted through the same Source.
**Compounding**

Rule Conditions can also be compounded using the AND/OR operator.

- Use AND if both Rule Conditions must be met, or
- Use OR if one of the Rule Conditions must be met

Proper utilization of compounded conditions can help reduce the number of rules required to achieve the desired results. For example, rather than creating individual rules to apply PDF security to a number of different file types, the same result could be achieved with one rule and multiple "OR" conditions for each file type.

String values must be enclosed in quotation marks within Rule Conditions.

*Figure 130 - Or Condition*

If you need to specify AND + OR conditions in the same statement, you should use brackets to explicitly control the outcome using the Source tab on the Rule Condition window. For example, both conditions to be used to create a rule condition in which the associated rule setting(s) would only be applied if the input file was based on a certain document template OR if the file name contains certain information AND if the input came from a specific Source.

For more information on creating Rule Sets with nested equations, contact Adlib.
**Rule Ordering**

Rules always evaluate in the order they appear in the Rule Set (top down). The order of Rule evaluation can greatly affect the outcome. Keep in mind that all rules within a Rule Set will be evaluated; if a rule is created that excludes a certain file type is placed at the top of the Rule Setting order and it does not contain an exit flag, the other rules in the Rule Set will also be applied to the previously excluded file, and may negate the intent of the higher level rule.

When defining Job Acceptance Rules, place general Rules at the top of the Rules list and more specific rules lower in the list. Place Default Rules, which are rules that apply to all content, at the very bottom of the Rules list so they are only evaluated if ALL other Rules evaluate to False with no Exit Flags.

When defining Transformation Rules, the reverse is true. Place Default Rules at the top of the Rules list.

**Rule Hierarchy**

During job processing, rules are evaluated in the order they appear in the Instruction Set. Job Acceptance rules are evaluated to determine if content will be accepted for processing, while Transformation Rules specify how the content will be transformed. The Rule hierarchy within an Instruction Set can be modified by dragging rules into the desired order.
What Are the Stages of Job Processing?

The process of document transformation begins when a Connector detects input in a Source repository that it is monitoring. When a new job becomes available, the Connector extracts the metadata content from the Source and submits it to the Job Management Service. The Job Management Service evaluates the associated Job Acceptance rule(s) and if accepted, submits the accepted job to the database.

The System Manager is constantly polling the database for jobs it can process. When a new job is detected, the System Manager evaluates the Transformation rules associated with the content from that Source, creates a job ticket and submits the ticket to the database. The Transformation Engine picks up the job, performs the transformation according to the job ticket and writes the completed job back to the database. The Connector, which has been polling the database for completed jobs, uploads the transformed job into the Source output folder or repository.

In addition to the Components that perform content transformation, Adlib PDF contains a Process Manager whose role it is to stop, start and monitor the Transformation Engine, Connector(s) and System Manager. The System Manager also monitors the health of Adlib PDF Components and reports alerts to the system administrator.

Job Processing

When a job is processed by Adlib PDF it proceeds through many identified states as it is handled by different Components:

- **Initialized**: A Connector detects that new input is available in a Source repository that it is monitoring. The Connector extracts the content from the Source, submits it to the Job Management Service, and flags the job as Initialized.
- **Committed**: The Job Management Service evaluates the associated Job Acceptance rule(s) and submits the accepted job to the database in a committed state.
- **Ready**: When a committed job is detected in the database by the System Manager, it prepares the job by evaluating the Transformation rules associated with the content from that Source. Based on that information, it creates a job ticket, submits the ticket to the database, and puts the job in the ready state in the database.
- **Completed**: The Transformation Engine picks up the ready job, performs the transformation according to the job ticket, and writes the completed status back to the database. The Connector, which has been polling for completed jobs, uploads the transformed job into the Source output folder or repository.
How Do I Configure Adlib PDF for High Availability?

Adlib PDF can easily be configured to run on multiple servers in order to add processing capacity, load balancing capabilities, redundancy, or to fill other business requirements. Using the Custom installation process, users can install only the Components they wish to add to the system on a given machine, such as a Transformation Engine, while maintaining control of the entire system from the Management Console.

By adding additional servers to Adlib PDF, the system can be configured to ensure that processing capacity is always available for high priority jobs, without interrupting the flow of normal operations. In the same way, a multi-server system could be configured to route only large jobs to a specific server, while balancing the remainder of work over the other servers.

System redundancy for other Components such as Connectors can be achieved by installing multiple Components that perform the same function on additional servers. This configuration is easily managed through modifications to the Process Manager settings.

Each Component, no matter which machine it has been installed on, is monitored by the Management Console. This benefit of Adlib PDF provides for easier troubleshooting, in that users do not have to remotely log into various servers to find the appropriate log file when there is an issue, and with all error logs consolidated in one place, it is easier to determine if a problem is system or job related.

Configuring System Settings

Multi-server installations require minimal additional configuration in order to function within the system. If a user merely wishes to add processing capacity, no additional settings are required once the servers have been installed, however, if a user wishes to allow for Priority job processing or load balancing in some other fashion, the Transformation Engines must be labeled using Environmental System Settings (or “Initialization Settings”) so that jobs can be routed to the appropriate server during processing.

If multiple Components have been installed, changes many also be required to the Process Manager Component, depending on the configuration of the system.

For more information on configuring Adlib PDF to suit your unique business requirements, please Contact Adlib.
How Do I Find Out Why My Job Failed?

Adlib PDF provides a reporting mechanism for Component health monitoring, troubleshooting, system and job logging, and performance reporting. Job and system information is collected in a central database to capture vital system statistics and facilitate reporting.

The Job Status page provides detailed information about each job submitted; this information can be used to troubleshoot in the event that an unexpected result is returned. The database can be queried for job information based on the specified search criteria. The Search results are displayed in the grid portion of the page.

The most common results of job processing include:

- **Completed Successful**: Job executed successfully from end to end. Note: A "Successful" status does not mean that all rules gave the expected result. For example, a successful job may fail to retrieve an incorrectly spelled variable or fail to apply a rule because rule conditions were configured incorrectly. In these cases, viewing the logs may be useful to determine which rules were applied and how they were evaluated for a particular job.

- **Completed Failed**: An issue occurred at some point during job execution that caused the job to fail. The Transformation Engine received the job, but could not successfully complete the job processing.

- **Completed JAR Rejected**: The job was rejected due to the evaluation of a Job Acceptance Rule.

**Viewing Job Processing Logs**

A Job Processing Log is created for each job, and can contain varying amounts of data depending on the log levels that are set for each Component. If a job produces unexpected results, it can be helpful to review the sections of the log related to rule processing and the input values that are passed in with the document.

1. **To Access and Review Job Processing Logs:**
   1. Navigate to the Job Status tab and expand the job you wish to view.
2. To view the log, click the Job tab, then click the Job Processing button.

*Figure 132 - Job Processing Log Button*

3. The log will be displayed in an XML Visualizer, in either a Treeview or Source format.

4. On the Source tab, to locate Job Acceptance rule processing details, search for the section beginning with "Process Jar Result".

   In the log sample below:
   - The Rule Condition defined for a File Size Job Acceptance Rule is evaluated (does file size exceed 3Mb?) as true, therefore
   - The Rule Setting is applied (Accepted = false)

*Figure 133 - Job Acceptance Rule Evaluation*

5. To locate Transformation Rule processing details, search for the section beginning with "Rule Results".

6. In the log sample below,
   - The Rule Condition defined for a Watermark rule is evaluated (does the Source ID = Confidential (numeric value equivalent)?) as true, therefore
   - The Rule Setting is applied (watermark text = Confidential)
If the Job has failed due to an issue with a Component, it may be helpful to review the System Logs created during the job processing.

↓ **To Observe System Logs for a Completed Job:**

1. Navigate to the *Job Status* page and click the link in the Job Id column that corresponds to the completed job you wish to investigate.

**TIP**

The Job Id is a unique GUID that is generated for each job.
2. The System Log page opens, pre-filtered with results from the job identified by Job Id. The Logger Name column lists messages from each Component as the job passed through the system.

Figure 136 - System Log - Filtered by Job Id

3. Observe the entries as the job flows from Source Input to Source Output (or failure).
What Do I Do if a Component is Generating an Alarm?

When an Adlib PDF Component is in an alarm state (e.g. faulted, stalled), it is flagged on the System Status Overview with a flashing warning indicator.

- Clicking on a Component box in the Overview opens the System Status page, filtered to display information about the selected Component.
- When alarms are acknowledged on the System Status page, the warning indicator state changes from flashing to solid.
- Once the issue that caused the alarm is resolved, the warning indicator is no longer displayed in the Overview.

Figure 137 - System Status with Alarm Indicators.
To Acknowledge Alarms

1. On the System Status Overview, click on a Component box that displays a flashing warning indicator.
2. Adlib PDF opens the System Status filtered for the Component selected.
   
   For example, if the System Manager Component box displays a warning indicator, clicking on the box opens the System Status page filtered to display System Manager Components only.

Component Status

The status of each Adlib PDF Component can be viewed on the System Status tab on the Monitoring Page.

Figure 138 - System Status

A Component can have any one of the following statuses:

- **Faulted** - Component has sent a fault error
- **Initialized** - Component is initialized but has not completed starting
- **Installed** - Component is installed but has never been started
- **Stalled** - Component has stopped heartbeating
- **Started** - Component is started and is working
- **Stopped** - Component has been stopped
- **Uninstalled** - Component has been uninstalled

Since the SharePoint Workflow Connector is started when a workflow is initiated, the operational status for that Component is **Installed**, not **Started**.
Currently, there are two Job Management Service Components installed with Adlib PDF. One, identified by the version (1.8) and install path (C:\Program Files\Adlib\Web\JobManagementService\bin) is a WCF-based Service for use with a Generic (Custom) Connector. The second, identified by the version (3.8) and path (C:\Program Files\Adlib\Web\DirectorWSA\bin) is used by the other Adlib PDF Connectors. The Component Status of the Job Management Services may appear as “Stalled” if a sizable amount of time passes between jobs, even though the Components remain functional.

Restarting Process Manager
A Component that is in Installed or Stopped status can usually be restarted by restarting the Process Manager Service.

To Restart Process Manager:
1. Select Control Panel from the Windows Start menu, then open Administrative Tools/Services. Select the Adlib Process Manager Service, and click Restart the Service.

Figure 139 - Restart Process Manager

Viewing System Logs
If restarting Process Manager does not bring the affected Component back to a “Started” status, it may be helpful to view the System logs for that Component. For more information on accessing System Logs, see How Do I Find Out Why My Job Failed?
Why Can I Not Process Any Jobs?

The Transformation Engine must be properly licensed before jobs can be processed. An expired or unlicensed Engine will show an "Initialized" status, and cannot be restarted with the Process Manager Service. Use the License Manager application, which is accessed from the Adlib PDF Start Menu group, to view existing licenses and perform various licensing functions.

See the Adlib PDF Installation Guide for instructions on using the License Manager. For more information on your specific license needs, contact Adlib.
How Do I Change Logging Levels?

Adlib PDF can generate many levels of logging detail for job processing and system functions. Logs can be useful in many ways; a job processing log will show not only which rules were evaluated for the job, but also the order that the rules were processed in, the metadata values that were passed in with the document, and the results of each interaction with the Adlib Components. Likewise, Adlib PDF Component logs can be used to monitor processing capacity, load balancing, and if necessary, track and identify system problems across the entire system.

By default, Adlib PDF is set to "Debug on Error". This is a log setting that will create debug error logs for each job that is processed, but will then remove all the log information below a specified threshold (e.g. Info only) if no errors occur during processing. Information level logs are retained for successful jobs.

In the case where a job completed successfully but still produced unexpected results, it may be useful to temporarily increase the level of logging of successful jobs in order to troubleshoot various aspects of the processing of the job. For more information about job processing logs, see How Do I Find Out Why My Job Failed?

To change logging levels, the log level defaults must be changed for both the System Manager and Job Management Service Components and the job re-run before the new logs can be viewed.

To Change Logging Levels:

1. Log in to Adlib PDF and navigate to the System Settings page and select System Manager from the Environment Configure menu.

2. In the Rule Set Editor, click the Edit tab to enable editing of the rule settings.
3. Select **Edit** in the Adlib.SystemManager.Settings rule **Edit** menu.

*Figure 142 - Settings Rule Edit Menu*

4. In the **Completed Job Log Retention** section, select an alternate logging level from the drop-down lists in the **On Error** and/or **On Success** fields and click **OK**.

*Figure 143 - Logging Threshold Settings*

5. Click **Save** in the **Rule Set Editor**.
6. Click the System Settings tab again to navigate back to the Environments page and repeat this process in the Adlib.JobManagementService.Settings rule for the Job Management Service Component.

7. Navigate to the Environments page again and select Publish from the Edit menu to activate the changes to the Components.

8. Navigate to the Monitoring tab and click the System Status button.

9. Double-click the Log Level value for each Component and select the new log level (e.g. Trace) from the drop-down list.

Figure 144 - Change Component Log Levels

10. Re-run the job and view the modified Job Status log on the Monitoring page.

How Do I Get Rid of the Input File Extension in the Rendered PDF?

By default, when using Folder Connector to submit jobs, the input file extension is retained in the rendered output file. The extension can be removed by modifying the Folder Connector Behavior System Setting and instructing the system to retain only the Input Base File name within the processed job name.

To Modify the Output File Name:

1. Click the System Settings tab and select Folder Connector from the Environment Settings menu.
2. Select the Edit tab to enable the Rule Set Editor.
4. In the Edit Behavior Rule Setting window, expand the Job Files section then expand Output.
5. Select the **Naming** checkbox, then click the **Metadata** button.

6. In the **Metadata Selector** window, expand **Variables Submitted with Jobs**, then expand **FolderConnector**.

7. Select **Adlib.Connectors.InputBaseFileName** and click **Insert Selection**.
8. Click **OK**.

9. Click **Save** in the *Rule Set Editor* to save the Rule Setting changes.

10. Navigate back to the *System Settings* page and select **Publish** from the Environment Edit menu to activate the new configuration.
How Do I Change the Input File Destination After Job Processing?

By default, when using Folder Connector to submit jobs, the input file is placed in the output folder along with the processed job file, but this configuration can be modified within the Folder Connector Behavior System Setting. Input files can be deleted, moved to the Output folder specified for the Source, or moved to an alternate destination folder once job processing in complete.

To Modify the Input File Destination After Job Processing:

1. Click the System Settings tab and select Folder Connector from the Environment Settings menu.
2. Select the Edit tab to enable the Rule Set Editor.

Figure 147 - Folder Connector Behavior Edit Menu

4. In the Edit Behavior Rule Setting window, expand the Job Files section then expand Input.
5. Select the **Handling** checkbox, then select the desired Handling Option.

*Figure 148 - Input Handling Options*

6. Click **OK**.

7. Click **Save** in the *Rule Set Editor* to save the Rule Setting changes.

8. Navigate back to the *System Settings* page and select **Publish** from the Environment Edit menu to activate the new configuration.
Appendix B: Database Growth Management

Database Growth Management settings are included with Adlib PDF to assist the user in controlling database growth as a result of the job information that is retained during the operation of the system. When logging in Info mode, approximately 200KB of job information will be retained per successful job. Unsuccessful jobs and/or higher logging levels may retain additional information, requiring up to 3-4x as much space in the database.

When configuring the Database Growth Management settings, the following formula can be used to determine the minimum disk space required relative to the time elapsed between database cleanup procedures:

\[ 200 \text{ KB} \times \text{Average Number of Active Jobs in the Adlib System} = \text{Estimated Database Growth Per Day} \]

Once the minimum disk space has been determined, the default settings for Database Growth Management can be adjusted relative to the speed at which the disk space will be used up, based on the number of jobs run through Adlib PDF.

For example, if 1,000 jobs are run through the system a day, the estimated minimum disk space required will be approximately 195MB per day. By default, Database Growth Management will perform a cleanup procedure once per day, and will purge any job information that is older than 90 days. Using the calculations in this example, the database will have grown approximately 17GB in that time. If the default rate of database cleanup is not sufficient, the settings can be configured to suit the needs of the user.

Database Growth Management Modes

Database Growth Management runs in two modes:

**Mode 1: SQL Express only**

Since SQL Express databases have a data size cap (4GB for Express 2005, 10GB for Express 2008) a mandatory “by-size” cleanup will be performed when this type of database is detected. Every hour, Database Growth Management will check if the database has reached 80% of capacity. If it has, enough records will be purged to reduce the size to 50% of capacity. This is an automatic function and is not configurable.

**Mode 2: All Databases**

For all database types, the user can configure a “by-age” cleanup. This process runs once a day and purges any job information that is older than the configured age. By default, the Database Growth Management procedure will purge jobs and any associated child records older than 90 days at 2:00am local time.
For more information on adjusting these settings, see *To Configure Database Growth Management Settings*.

---

**Database Tables**

The following tables are involved in the cleanup process:

- SRT_JOB_ARCHIVE
- SRT_JOB_DOCUMENT_ARCHIVE
- SRT_JOB_GROUP
- ELS_LOG_ENTRY
- ELS_STATISTIC_ENTRY

Any records in the ELS tables associated with a purged job will be purged themselves (the JOB_CONTEXT field is checked for the association). Additionally, any unassociated records in these tables (null/empty JOB_CONTEXT field) older than the purged job will also be removed. Therefore the database will never retain any ELS records older than the most recently purged job.

---

**Configuring Database Growth Management Settings**

**To Configure Database Growth Management Settings:**

The following Adlib *System Manager* settings control the timing and age of the records effected by the Database Growth Management cleanup procedure:

- **Record Cleanup Age**: The age in days of job and log records to clean up.
- **Run Cleanup Time**: The hour of the day in local time (0-23) in which the cleanup will run.

The default settings can be modified to suit the needs of the user using the following procedure.

1. In the Adlib Management Console, navigate to the *Systems Settings* page.
2. Select **System Manager** from the Environment **Configure** Menu.

*Figure 149 - Environment Settings Menu*

3. In the **Rule Set Editor**, select the **Edit** tab.

4. Select **Edit** from the **Edit** menu of the Adlib.SystemManager.Settings Rule Setting.

*Figure 150 - Edit System Manager Rule Setting*

5. In the Database Growth Management section, enter the desired age (in days) of archived jobs to be retained in the database in the **Record Cleanup Age** field.
6. Specify the desired time to run the database cleanup by entering the number associated with the hour of the day in local time (0-23) in the Run Cleanup Time field.

Figure 151 - System Manager Rule Setting

7. Click OK. Click Save in the Rule Set Editor.

8. To activate the changes made to the System Manager Rule Settings, navigate back to the Environments tab on the System Settings page. A green caution symbol indicates that unpublished changes have been detected. Click the symbol to publish the changes.

Figure 152 - Publish Rule Setting Changes
Appendix C: Content Transformation
Viewers and Supported File Types

Adlib PDF provides automated document conversion of over 300 file types to PDF, Text, and Image. During content rendering, the Transformation Engine uses a “viewer” in preparation for transformation to the specified format. In order to select the appropriate rendering viewer, the Transformation Engine must first identify the file type being converted by reading the header and/or the file extension. Once the file type has been identified, the document is rendered and output to the format specified in the Rule Setting.

Native Application Support (NAS)

Adlib PDF supports native applications (e.g. Microsoft Excel) as viewers which are used to render their associated document types (e.g. xls) during the transformation process. This method ensures the highest rendering accuracy and is recommended for complex documents such as word processing files that contain tables, graphics, etc. In order to ensure the best quality output, it is recommended that all native applications be installed on the Transformation Engine servers that will process those files.

Although it is not strictly necessary, for more precise control of document rendering the user can include a “native application viewer-specific” Rule Setting within the Instruction Set that will be used to process those file types. These Rule Settings control attributes that are specific to the native application viewer and affect how the associated file types will be rendered.

For example, using the Rule Setting “ConvertToPdf.MicrosoftWord”, the user can control elements such as the compression of images, the embedding of fonts, and the creation of content bookmarks.

A list of the Rule Settings associated each supported native application is displayed below.

Some file types can only be rendered using native application support. See the supported File Types table for details.

Supported Native Applications and Associated Rule Settings

This table contains a list of the currently supported native applications; additional applications (and versions) are always being added.

This table refers to only the English versions of each application. Alternative language versions of these applications are not officially supported by Adlib PDF.

<table>
<thead>
<tr>
<th>Mfgr</th>
<th>Application</th>
<th>Version/Format</th>
<th>Rule Setting(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe</td>
<td>Framemaker</td>
<td>6.0, 7.0</td>
<td>ConvertToPdf.AdobeFramemaker</td>
</tr>
<tr>
<td>Corel</td>
<td>CorelDRAW</td>
<td>8.0, 12.0</td>
<td>ConvertToPdf.CorelCorelDraw</td>
</tr>
<tr>
<td>Corel</td>
<td>WordPerfect</td>
<td>8.0 to X5(^1)</td>
<td>ConvertToPdf.CorelWordPerfect</td>
</tr>
<tr>
<td>Ghostscript</td>
<td>Ghostscript</td>
<td>7.04 to 8.15 (32-bit only)</td>
<td>ConvertToPdf.GhostscriptExport</td>
</tr>
</tbody>
</table>
### Native Application Notes:

1. Internal content hyperlink creation not supported for WordPerfect. X4 and X5 only validated for Windows Server 2003 32-bit environment.
2. Microsoft Office 2003 Service Pack 1 (or greater) required.
4. It is recommended that the Save AutoRecover options within Word, Excel and PowerPoint be disabled.
5. Support is currently available for only the 32-bit versions of Microsoft Infopath, Word, Excel, Powerpoint, Project and Visio 2010.

### Adlib Viewer Support

Adlib viewers are installed with the Transformation Engine and are used to render Text (non-unicode), Images, HPGL, MSG and PDF file types. This method ensures the highest rendering accuracy and efficiency for these document types.

If desired, users can use the File Type-specific Rule Settings to maintain control over specific aspects of the rendering of these file types, however in the absence of these Settings, the Transformation Engine will automatically process these files with an Adlib Viewer using system defaults.
Adlib Viewer Supported File Types and Associated Rule Settings

<table>
<thead>
<tr>
<th>Input File Type</th>
<th>Output File Type</th>
<th>Rule Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF</td>
<td>HTML</td>
<td>ConvertToHtml.Pdf</td>
</tr>
<tr>
<td>PDF</td>
<td>JPEG</td>
<td>ConvertToJpeg.Pdf</td>
</tr>
<tr>
<td>CAD¹</td>
<td>PDF</td>
<td>ConvertToPdf.CAD</td>
</tr>
<tr>
<td>Image²</td>
<td>PDF</td>
<td>ConvertToPdf.Image</td>
</tr>
<tr>
<td>OCR²</td>
<td>PDF</td>
<td>ConvertToPdf.Ocr</td>
</tr>
<tr>
<td>Text (non-unicode)</td>
<td>PDF</td>
<td>ConvertToPdf.Text</td>
</tr>
<tr>
<td>XSL-FO</td>
<td>PDF</td>
<td>ConvertToPdf.XslFo</td>
</tr>
<tr>
<td>PDF</td>
<td>Png</td>
<td>ConvertToPng.Pdf</td>
</tr>
<tr>
<td>PDF</td>
<td>Text</td>
<td>ConvertToText.Pdf</td>
</tr>
<tr>
<td>PDF</td>
<td>Tiff</td>
<td>ConvertToTiff.Pdf</td>
</tr>
<tr>
<td>PDF</td>
<td>Cals</td>
<td>ConvertToCals.Pdf</td>
</tr>
<tr>
<td>PDF</td>
<td>Gif</td>
<td>ConvertToGif.Pdf</td>
</tr>
<tr>
<td>PDF</td>
<td>Xps</td>
<td>ConvertToXps.Pdf</td>
</tr>
</tbody>
</table>

Adlib Viewer Notes:
1. Requires a CAD license.
2. For a list of all supported Image and OCR input file types see the Supported File Types table.

Generic Viewer Support
The Generic viewer is installed with the Transformation Engine and supports the rendering of hundreds of file types. This method ensures rendering efficiency without requiring additional software to be installed on the computer performing the conversion. The Generic method renders simple documents accurately but may not render complex documents as well as the native application used to create the document. We recommend that customers process a number of documents using both the Generic and NAS methods to identify the method which is most suitable.

The Generic viewer Rule Setting, “ConvertToPdf.Generic” enables users to control the use of embedded fonts and image compression and resolution where required. This setting can also be used to direct the Adlib Platform to substitute the Generic viewer for a native application viewer in the case where a native application will not be installed on the Transformation Engine server used to transform the file.

For a list of all file types that are currently supported by the Generic viewer, see the Supported File Types table.
## Supported File Types

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Extensions</th>
<th>Versions/Formats</th>
<th>NAS</th>
<th>Adlib</th>
<th>Generic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Acrobat</td>
<td>PDF</td>
<td>All</td>
<td></td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Adobe FrameMaker</td>
<td>MIF</td>
<td>6.0</td>
<td></td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Adobe FrameMaker</td>
<td>FM</td>
<td>6.0</td>
<td></td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Adobe FrameMaker graphics</td>
<td>FMV</td>
<td>Vector/raster to 5.0</td>
<td></td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Adobe Illustrator</td>
<td>AI</td>
<td>1.0 to 7.0, 9.0, CS3</td>
<td></td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Adobe Photoshop</td>
<td>PSD</td>
<td>4.0, CS3</td>
<td></td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Ami Draw</td>
<td>SDW</td>
<td>Ami Draw</td>
<td></td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>ANSI Text</td>
<td>TXT</td>
<td>7 &amp; 8 bit</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>ASCII Text</td>
<td>TXT</td>
<td>7 &amp; 8 bit</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>AutoCAD Drawing Web Format</td>
<td>DWF</td>
<td>2012 and below</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>AutoCAD Interchange</td>
<td>DXF</td>
<td>2012 and below</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>AutoCAD Native Drawing</td>
<td>DWG</td>
<td>2012 and below</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>AutoDesk Inventor</td>
<td>DWG, IAM, IDW, IPT</td>
<td>11 and below</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>AutoDesk Inventor</td>
<td>DWG, IAM, IDW, IPT</td>
<td>2011, 2012</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>AutoShade Rendering</td>
<td>RND</td>
<td>2.0</td>
<td></td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Bentley MicroStation Drawing</td>
<td>DGN</td>
<td>8.9, 8.5, 8.1, and below</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Binary Group 3 Fax</td>
<td>All</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Bitmap</td>
<td>BMP, ICO, DIB</td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>CADKEY</td>
<td>PRT</td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>CalComp PCI 906/907 Plot</td>
<td>906</td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>CALS Group IV</td>
<td>CAL, CG4, MIL, ODA, C4</td>
<td>Type I, Type II</td>
<td></td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>CAMCAD</td>
<td>CC</td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>CIT Intergraph Group IV</td>
<td>CIT</td>
<td>All</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Computer Graphics Metafile</td>
<td>CGM</td>
<td>ANSI, CALS</td>
<td></td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>File Type</td>
<td>File Extensions</td>
<td>Versions/Formats</td>
<td>NAS</td>
<td>Adlib</td>
<td>Generic</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-----</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>Computer Graphics Metafile</td>
<td>CGM</td>
<td>4</td>
<td>✓</td>
<td>✓</td>
<td>1</td>
</tr>
<tr>
<td>Corel Clipart format</td>
<td>CMX</td>
<td>5.0 to 6.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Corel Draw</td>
<td>CDR with TIFF header</td>
<td>2.0 to 9.0</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Corel Draw</td>
<td>CDR</td>
<td>6.0 to 12.0</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Corel/Novell Presentations</td>
<td></td>
<td>1.0 to 10</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Corel/Novell Quattro Pro</td>
<td></td>
<td>1.0 to 12</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Corel/Novell WordPerfect</td>
<td>WPD, WP5</td>
<td>1.0 to 12, X3</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DataEase</td>
<td></td>
<td>4.x</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dBASE</td>
<td></td>
<td>1.0 to 5.0</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dBXL</td>
<td></td>
<td>1.3</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEC WPS Plus</td>
<td>DX</td>
<td>1.0 to 4.0</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEC WPS Plus</td>
<td>WPL</td>
<td>1.0 to 4.1</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DG Auto-trol Vector</td>
<td>DG</td>
<td></td>
<td>✓1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DisplayWrite 2 &amp; 3</td>
<td>TXT</td>
<td>All</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DisplayWrite 4 &amp; 5</td>
<td></td>
<td>1.0 to 2.0</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td></td>
<td>3.0, 4.0, 4.5</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Encapsulated PostScript</td>
<td>EPS</td>
<td>TIFF header only</td>
<td>✓10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Executable</td>
<td>EXE, DLL</td>
<td></td>
<td>✓7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Executable for Windows NT</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extensible Markup Language</td>
<td>XML, XSL</td>
<td>All</td>
<td>✓4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>First Choice</td>
<td></td>
<td>1.0 to 3.0</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FoxBase</td>
<td></td>
<td>2.1</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Framework</td>
<td></td>
<td>3.0</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freelance for OS/2</td>
<td></td>
<td>1.0 to 2.0</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Freelance for Windows</td>
<td></td>
<td>1.0 to 9.6</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GEM Paint</td>
<td>IMG</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graphics Environment Manager</td>
<td>GEM</td>
<td>Bitmap &amp; vector</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Type</td>
<td>File Extensions</td>
<td>Versions/Formats</td>
<td>NAS</td>
<td>Adlib</td>
<td>Generic</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-----</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>Graphics Interchange Format</td>
<td>GIF</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓18</td>
</tr>
<tr>
<td>GZIP Compression Utility</td>
<td>GZ</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Harvard Graphics for DOS</td>
<td>2.x, 3.x</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Harvard Graphics for Windows</td>
<td>PRS</td>
<td>All</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Hewlett Packard Graphics Language</td>
<td>HP, HPGL, HGL, HPG, PLT, 000, HPGL/2</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Hewlett Packard Graphics Language</td>
<td>HPGL, HPGL/2</td>
<td></td>
<td>✓1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hewlett Packard ME10</td>
<td>CMI, MI</td>
<td>13 and below</td>
<td></td>
<td>✓1</td>
<td></td>
</tr>
<tr>
<td>Hypertext Markup Language</td>
<td>HTM, HTML</td>
<td>1.0 to 3.0</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Hypertext Markup Language</td>
<td>HTM, HTML, CSS</td>
<td>All</td>
<td>✓3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBM FFT</td>
<td>All</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBM Graphics Data Format</td>
<td>GDF</td>
<td>1.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>IBM Picture Interchange Format</td>
<td>PIF</td>
<td>1.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>IBM Revisable Form Text</td>
<td>All</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBM Writing Assistant</td>
<td>1.01</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Initial Graphics Exchange Specification</td>
<td>IGES</td>
<td>5.2</td>
<td>✓1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Joint Photographic Experts Group</td>
<td>JPG, JPEG, JPE</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓18</td>
</tr>
<tr>
<td>JPEG 2000</td>
<td>J2K, JP2</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JPEG (Progressive)</td>
<td>JPG, JPEG, JPE</td>
<td>All</td>
<td>✓</td>
<td>✓</td>
<td>✓18</td>
</tr>
<tr>
<td>JPEG File Interchange Format</td>
<td>JFIF</td>
<td>All</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JPG with EXIF</td>
<td>JPG, JPEG, JPE</td>
<td></td>
<td>✓</td>
<td></td>
<td>✓18</td>
</tr>
<tr>
<td>JustSystems Ichitaro</td>
<td>5.0, 6.0, 8.0, 9.0</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JustWrite</td>
<td>1.0 to 3.0</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Kodak Flash Pix</td>
<td>FPX</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Type</td>
<td>File Extensions</td>
<td>Versions/Formats</td>
<td>NAS</td>
<td>Adlib</td>
<td>Generic</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-----</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>Kodak Photo CD</td>
<td>PCD</td>
<td>1.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Legacy</td>
<td>LEG</td>
<td>1.0 to 1.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lotus 1-2-3 (DOS &amp; Windows)</td>
<td>WK1, WK3, WK4, WKS</td>
<td>1.0 to 5.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lotus 1-2-3 (OS/2)</td>
<td></td>
<td>1.0 to 2.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lotus 1-2-3 Charts (DOS &amp; Windows)</td>
<td>WK1, WK3, WK4, WKS</td>
<td>1.0 to 5.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lotus 1-2-3 for SmartSuite</td>
<td>WK1, WK3, WK4, WKS</td>
<td>97 to 9.6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lotus AMI/AMI Professional</td>
<td></td>
<td>1.0 to 3.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lotus Manuscript</td>
<td></td>
<td>2.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lotus Notes</td>
<td>NSF</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lotus PIC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lotus Snapshot</td>
<td></td>
<td>All</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lotus Symphony</td>
<td></td>
<td>1.0, 1.1, 2.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lotus Word Pro</td>
<td>LWP, MWP</td>
<td>96 to 9.8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LZA Self Extracting Compress</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LZW Compression</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Macintosh PICT1 &amp; PICT2</td>
<td></td>
<td>Bitmap only</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MacPaint</td>
<td>PNTG</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MacWrite II</td>
<td></td>
<td>1.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MASS11</td>
<td>M11</td>
<td>1.0 to 8.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Micrografx Designer</td>
<td>DRW</td>
<td>1.0 to 3.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Micrografx Designer</td>
<td>DSF</td>
<td>6.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Micrografx Draw</td>
<td>DRW</td>
<td>1.0 to 4.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Access</td>
<td></td>
<td>1.0 to 2.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Binder</td>
<td>OBD</td>
<td>7.0 to 97</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Excel Charts</td>
<td>XLC</td>
<td>2.x to 7.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Excel</td>
<td>XML</td>
<td>2003</td>
<td></td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>Microsoft Excel</td>
<td>XLS, XLT</td>
<td>2.2 to 2003</td>
<td></td>
<td></td>
<td>15</td>
</tr>
<tr>
<td>File Type</td>
<td>File Extensions</td>
<td>Versions/Formats</td>
<td>NAS</td>
<td>Adlib</td>
<td>Generic</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-----</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>Microsoft Excel</td>
<td>XLSX</td>
<td>2007, 2010</td>
<td>✅14, 15</td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Microsoft Infopath</td>
<td>XSN</td>
<td>2003, 2007, 2010</td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Microsoft Multiplan</td>
<td></td>
<td>4.0</td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Microsoft Outlook</td>
<td>MSG</td>
<td>2003, 2007, 2010</td>
<td>✅</td>
<td>✅</td>
<td>✅</td>
</tr>
<tr>
<td>Microsoft Outlook Express</td>
<td>EML</td>
<td></td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Microsoft PowerPoint</td>
<td>PPT, PPS</td>
<td>3.0 to 2003</td>
<td>✅15</td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Microsoft PowerPoint</td>
<td>PPTX</td>
<td>2007, 2010</td>
<td>✅14,15,17</td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Microsoft PowerPoint</td>
<td>POT</td>
<td>3.0 to 2010</td>
<td>✅15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Project</td>
<td></td>
<td>98 Text only</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Project</td>
<td></td>
<td>2002 to 2010</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Rich Text Format</td>
<td>RTF</td>
<td>All</td>
<td>✅9</td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Microsoft Snapshot Viewer</td>
<td>SNP</td>
<td>9.0 to 11</td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Microsoft Visio</td>
<td>VSD</td>
<td>All</td>
<td>✅15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Windows Write</td>
<td></td>
<td>1.0 to 3.0</td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Microsoft Word</td>
<td>XML</td>
<td>2003</td>
<td>✅5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Word</td>
<td>DOC</td>
<td>1.0 to 2003</td>
<td>✅15</td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Microsoft Word</td>
<td>DOCX</td>
<td>2007, 2010</td>
<td>✅14.15</td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Microsoft Word</td>
<td>DOT</td>
<td>1.0 to 2010</td>
<td>✅15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft WordPad</td>
<td>RTF</td>
<td>All</td>
<td>✅9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Works</td>
<td></td>
<td>1.0 to 2.0</td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Microsoft Works (DOS)</td>
<td></td>
<td>1.0 to 2.0</td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Microsoft Works (Mac)</td>
<td></td>
<td>1.0 to 2.0</td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Microsoft Works</td>
<td>WPS</td>
<td>1.0 to 4.0</td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>MIME HTML</td>
<td>MHT</td>
<td></td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>MIME Text Mail</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Mosaic Twin</td>
<td></td>
<td>2.5</td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>MultiMate</td>
<td></td>
<td>1.0 to 4.0</td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>File Type</td>
<td>File Extensions</td>
<td>Versions/Formats</td>
<td>NAS</td>
<td>Adlib</td>
<td>Generic</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------------</td>
<td>-----------------</td>
<td>-----</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>Navy DIF</td>
<td>All</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Nota Bene</td>
<td>3.0</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Novell Perfect Works</td>
<td>2.0</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Novell Perfect Works (Draw)</td>
<td>2.0</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Novell Quattro Pro for DOS</td>
<td>WB1</td>
<td>1.0 to 5.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Nuance OmniPage/ PaperPort</td>
<td>MAX</td>
<td></td>
<td>✓11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OpenOffice.org Calc</td>
<td>ODS, OTS, SXC, STC</td>
<td>1.0 to 3.0.1</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OpenOffice.org Impress</td>
<td>ODP, OTP, SXI, STI</td>
<td>1.0 to 3.0.1</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OpenOffice.org Writer</td>
<td>ODT, OTT, SXW, STW</td>
<td>1.0 to 3.0.1</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Office Writer</td>
<td>4.0 to 6.0</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>OrCAD</td>
<td>DSN</td>
<td>10</td>
<td>✓1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OS/2 PM Metafile</td>
<td>MET</td>
<td>3.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Paint Shop Pro 6 Win32 only</td>
<td>PSP</td>
<td>5.0 to 6.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Paradox (DOS)</td>
<td>1.0 to 4.0</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Paradox (Windows)</td>
<td>1.0 to 1.0</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>PC Paintbrush</td>
<td>DCX, PCX</td>
<td></td>
<td>✓18</td>
<td>✓18</td>
<td></td>
</tr>
<tr>
<td>PC-File Letter</td>
<td></td>
<td>1.0 to 5.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Personal R:BASE</td>
<td>1.0</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>PFS:Professional Plan</td>
<td>1.0</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>PFS:Write</td>
<td>A, B, C</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>PKWARE Archive</td>
<td>ZIP</td>
<td>All</td>
<td>✓16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Portable Bitmap</td>
<td>PBM</td>
<td>All</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Portable Graymap</td>
<td>PGM</td>
<td>All</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Portable Network Graphics</td>
<td>PNG</td>
<td>1.0</td>
<td>✓</td>
<td></td>
<td>✓18</td>
</tr>
<tr>
<td>Portable Pixmap</td>
<td>PPM</td>
<td>All</td>
<td>✓</td>
<td>✓18</td>
<td></td>
</tr>
<tr>
<td>Postscript</td>
<td>PS</td>
<td>Level II</td>
<td>✓12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Postscript</td>
<td>PS</td>
<td>Level II, III</td>
<td>✓2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Type</td>
<td>File Extensions</td>
<td>Versions/Formats</td>
<td>NAS</td>
<td>Adlib</td>
<td>Generic</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-----</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>Professional Write</td>
<td></td>
<td>1.0 to 2.1</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Professional Write Plus</td>
<td></td>
<td>1.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Q &amp; A</td>
<td></td>
<td>1.0 to 2.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Q &amp; A Write for Windows</td>
<td></td>
<td>3.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>R:BASE 5000</td>
<td></td>
<td>1.0 to 3.1</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>R:BASE System V</td>
<td></td>
<td>1.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Reflex</td>
<td></td>
<td>2.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>RLE Intergraph Runlength</td>
<td>RLE</td>
<td>All</td>
<td>✓1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Samna Word</td>
<td></td>
<td>1.0 to IV+</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Seagate Crystal Reports</td>
<td>RPT</td>
<td>4.6.1</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SmartWare II</td>
<td>DEF</td>
<td>1.02</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>SolidWorks 2D</td>
<td>SLDDRW</td>
<td>2008 and below</td>
<td>✓1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sprint</td>
<td></td>
<td>1.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>StarOffice Calc</td>
<td>SDC</td>
<td></td>
<td>✓13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>StarOffice Impress</td>
<td>SDA</td>
<td></td>
<td>✓13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>StarOffice Writer</td>
<td>SDW</td>
<td></td>
<td>✓13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sun Raster</td>
<td>SRS</td>
<td>All</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>SuperCalc 5</td>
<td></td>
<td>4.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Tagged Image File</td>
<td>TIF, SEP, TIFF, FAX</td>
<td>All</td>
<td>✓</td>
<td>✓18</td>
<td></td>
</tr>
<tr>
<td>Text Mail</td>
<td>MIME</td>
<td></td>
<td>✓</td>
<td>✓18</td>
<td></td>
</tr>
<tr>
<td>Total Word</td>
<td></td>
<td>1.2</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Truevision Targa</td>
<td>TGA, VDA, VST</td>
<td>2</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Unicode Text</td>
<td>TXT</td>
<td>All</td>
<td>✓6</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Unigraphics SolidEdge 2D</td>
<td>DFT</td>
<td>8 to 20</td>
<td>✓1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UNIX Compress</td>
<td>GZ</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>UNIX TAR</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>UUEncode</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>vCard</td>
<td>VCF</td>
<td>2.1</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>File Type</td>
<td>File Extensions</td>
<td>Versions/Formats</td>
<td>NAS</td>
<td>Adlib</td>
<td>Generic</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-----</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>Visio</td>
<td>VSD</td>
<td>5</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Visio (preview)</td>
<td></td>
<td>4</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Volkswriter 3 &amp; 4</td>
<td></td>
<td>1.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>VP Planner 3D</td>
<td></td>
<td>1.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Wang PC</td>
<td>IWP</td>
<td>1.0 to 2.6</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Wavesoft</td>
<td>MOT</td>
<td></td>
<td>✓ †</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WBMP</td>
<td></td>
<td>All</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Windows Enhanced Metafile</td>
<td>EMF</td>
<td>All</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Windows Metafile</td>
<td>WMF</td>
<td>All</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>WinFax</td>
<td>FXR</td>
<td>9.0, 10.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Wireless Markup Language</td>
<td>WML</td>
<td>5.2</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>WordMARC</td>
<td></td>
<td>1.0 to Composer</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>WordPerfect Graphics</td>
<td>WPG, WPG2</td>
<td>1.0 to 2.0</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>WordStar</td>
<td></td>
<td>1.0 to 7.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>WordStar 2000</td>
<td>DOC</td>
<td>1.0 to 3.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>WordStar for Windows</td>
<td>DOC</td>
<td>1.0</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>X-Windows Bitmap</td>
<td>XBM</td>
<td>x10 compatible</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>X-Windows Dump</td>
<td>XDM</td>
<td>x10 compatible</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>X-Windows Pixmap</td>
<td>XPM</td>
<td>x10 compatible</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>XSL Formatting Objects Form</td>
<td>FO, XML</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XyWrite</td>
<td>XYP</td>
<td>1.0 to III Plus</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

**Rendering Notes:**

1. Requires CAD License.
2. Requires Ghostscript.
3. Supports Hypertext Markup Language (HTML) with Cascading Style Sheets (CSS).
6. Requires WordPad.
7. The PDF will be a report of technical file information.
8. Only NSF files with one email are supported.
9. WordPad will be used to convert the document unless Microsoft Word is installed.

10. The Encapsulated PostScript (EPS) file specification allows a graphic file to be included for screen preview. The graphic file formats supported are: PICT (MAC), TIFF, Metafile and EPSI. The Adlib Transformation Engine only supports EPS files with TIFF graphic file format.


12. In some instances PostScript files have a loss in fidelity when rendering. Native Application (Ghostscript) processing produces higher quality PDF files and is recommended.

13. Requires OpenOffice.org equivalent (Calc, Impress or Write).


15. If using Microsoft Office 2007 NAS to render, Service Pack 2 is required.

16. Contents of the Zip file are merged into a single output. Contents appear in the order they were added to the Zip file.

17. It is recommended that High Quality printing be enabled within the PowerPoint 2007 native application. This setting provides the best quality when rendering PowerPoint files through the Adlib PDF Transformation Engine.

18. Extended File Type Support will only be used if there was a failure rendering the image file through the Adlib Image Viewer and the ConvertToPdf.Generic rule setting is applied within the Transformation Rules.

19. Autodesk Inventor View must installed prior to the Transformation Engine to support the rendering of these files when the ConvertToPdf.Cad setting has been configured under the Transformation Rules.

Additional file types are continually being added. If the file type you are looking for is not listed please email Adlib at support@adlibsoftware.com.

General Notes:

a) This list only contains the most common file extensions used for each file type. Other file extensions may exist.

b) File extensions are not used to identify the file type except for CAD files and files that do not contain file information (e.g. HPGL).

c) Please let us know if you need additional file type support.
Appendix D: Troubleshooting

Overview
This section serves as a guide to help troubleshoot problems that might occur while using Adlib PDF. It provides direction for diagnosing common issues and describes the steps required for resolution. It also offers tips on how to use Adlib PDF effectively.

- Common Issues
- Adlib Tips
- Using Metadata

Common Issues

Rule Set is locked
- Capture and save the screen
- Log back in as the user that had the Rule Set locked
- The lock will be reset.

Rule doesn’t seem to be taking effect
- Verify that the Rule script is correct:
  - Check for the correct use of quotes
- For Transformation or Job Acceptance Rules:
  - Confirm that the Instruction Set is published (check the Active Rule Set)
- For Component Initialization Settings:
  - Confirm that the Environment is published.
  - Ensure affected Components are restarted.
  - Investigate the Job Processing sub-tab in the Job Status log.

Refer to Job Status for parameter details.

Job information is not appearing on the Job Status / System Log screens
- Check the selected start and end date in the log filters.
- Ensure that no filters are active.

Installation does not complete successfully
- If one exists, check the installation log file.
- Ensure prerequisites have been installed.
- Enable verbose logging
Forgot password to access Adlib PDF
  - Ask your Database Administrator to check your Settings in the database’s user table.

Management Console screen is frozen (screen is grey)
  - Close your browser and re-open it.

File failed to process (it was placed in the error folder)
  - Navigate to the Job Status and check job details.
  - Filter the Job Status to the job in question.
  - Navigate to the System Log and check for errors.
  - Generate a problem report.

E-mail notifications not sent when Components go offline
  - Check the System Manager initialization Settings:
    - Verify that Component Error Max Notification is greater than zero
    - Ensure that all STMP Settings are configured correctly
    - Ensure that Component Error Recipients are configured correctly. For multiple recipients, use semi-colons between addresses.

Adlib Tips

How to maintain your database
If not properly maintained, the database will eventually grow to an unacceptable size.
  - Set up a regular schedule (perhaps once a month) to clear the els_log entries.
  - Enable e-mail notifications through the SQL Server.

The correct process to create a new Environment and Source
Basic setup, configuration, and use of Adlib PDF can be completed in five Basic Steps, which are described in detail under Management Console.
1. Define a New Environment
2. Define a Source
3. Configure Job Settings
4. Verify System Readiness
5. Submit Job

How to correctly unassign a Folder Connector from an Environment
Connectors must be removed in the reverse order in which they were added.
1. Navigate to Sources tab under System Settings.
   - Edit the Source in which the Connector is assigned.
   - Click the minus sign beside the Connector name to remove it and click Save.
Be sure to remove the Connector from all Sources in which it is assigned.

2. Navigate to Job Settings.
   - **Edit** the Instruction Set in which the Source (*which contained the Connector above*) is assigned.
   - Drag the Source form the Instruction Set work area to the toolbox.

Repeat for all Sources which contained the Connector.

3. Navigate to the Environments tab under System Settings.
   - **Edit** the Environment in which the Connector is assigned.
   - **Click the** minus sign beside the Connector name to remove it and click **Save**.

**Using Metadata**

The term **metadata** refers to contextual information that describes elements of a set of data, defined as name/value pairs. Metadata examples include input file size, folder name, document status, etc.

Within Adlib PDF:

- Users can define the metadata to be used
- Related metadata can be grouped under a single name
- Jobs can be run once to populate all available metadata
- Metadata can be obtained automatically from SharePoint or other repositories

**Metadata Selector**

The Metadata Selector window opens when the **Metadata** button is clicked in Rule Condition and Setting Attribute windows. Metadata selection is used to select Variables managed under the Global Variables tab on the System Settings page of Adlib PDF.

**Submit / Consume**

When selecting Metadata, the terms **Submit** and **Consume** refer to metadata submitted by and returned to Components:

- **Submit Metadata** is metadata provided by a Component that the Rules Engine uses during evaluation (**e.g. Component type, machine name, etc.**).
- **Consume Metadata** is metadata provided by the Rules Engine to a Component for consumption during processing (**e.g. header/footer Settings, watermark text, margins, etc.**).

Consumable metadata elements used for initialization are defined as Settings and represent a particular XML schema. When inactive, the schema can be modified through the target Rule.
Variables Tab

Variables registered under Global Variables will appear under the Variables tab if they have usage assigned. These include default Variables provided out-of-box with Adlib PDF as well as any user-defined Variables. Refer to Variables for detailed information on Variables and Variable Usage.

- **Variables Used to Identify Components** are Variables of usage type **Submit**.
- **Variables Submitted with Jobs are Variables** of usage type **Submit** that are also associated to any Connector Component type.
- **Variables Used to Initialize Components** are Variables of usage type **Consume**.

*Figure 153 - Metadata Selector Variables*
To Select a Metadata Variable

1. Click the arrow beside the type of Variable to be used.
2. Drill down and select one of the Variables listed.
3. Click Insert Selection.

*Figure 154 - Metadata Variable Selection*
Values Tab

The Values tab is used to insert tokens that identify certain types of objects registered to the system. These tokens will be resolved to the correct unique identifier for the selected object type.

Typically used in Rule Conditions, users can easily insert:

- Machine IDs,
- Installed Component IDs,
- Component Type IDs, and
- Source IDs.

*Figure 155 - Metadata Selector Values*
To Select a Metadata Value

1. Click the arrow beside the type of Value to be used.
2. Select one of the values listed.
3. Click Insert Selection.

Figure 156 - Metadata Value Selection
# Appendix E: Contact Adlib

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Web Site</strong></td>
<td><a href="http://www.adlibsoftware.com/">www.adlibsoftware.com/</a></td>
</tr>
<tr>
<td><strong>Sales</strong></td>
<td><a href="mailto:sales@adlibsoftware.com">sales@adlibsoftware.com</a></td>
</tr>
<tr>
<td><strong>Support</strong></td>
<td><a href="mailto:support@adlibsoftware.com">support@adlibsoftware.com</a></td>
</tr>
<tr>
<td><strong>Phone</strong></td>
<td>1-905-631-2875 or 1-866-991-1704 (North America Only)</td>
</tr>
<tr>
<td><strong>Fax</strong></td>
<td>1-905-639-3540</td>
</tr>
<tr>
<td><strong>Mail</strong></td>
<td>Adlib</td>
</tr>
<tr>
<td></td>
<td>215-3228 South Service Road</td>
</tr>
<tr>
<td></td>
<td>Burlington, Ontario L7N 3H8</td>
</tr>
<tr>
<td></td>
<td>Canada</td>
</tr>
</tbody>
</table>
# Appendix F: Index

## A
- Alarm: 21, 103, 109, 132

## C
- Completed On: 97
- Component: 19
- Component Friendly Name: 106
- Component Initialization Settings: 34
- Component Status: 103
- Component Type: 98, 103
- Connector: 10, 19
- Content Transformation Viewers: 70

## D
- Database: 21
- Database Growth Management: 142
- Configure Settings: 143
- Database Tables: 143
- Modes: 142
- Default Rule: 13
- Drop Zone: 21

## E
- Engine Complete Time: 100
- Engine Start Time: 100
- Environment: 11
- Environment Name: 97, 103
- Environments: 22
  - Define a New Environment: 25
  - Remove Environment Components: 30
  - Sort Environment Components: 32
  - Sort Unassigned Components: 32
  - View Component Information: 33
- Exit Flag: 13

## F
- Fault, Monitoring and Recovery Settings: 36
- Folder Connector: 37

## H
- Heartbeat: 21
- High Availability: 21
- How To
  - Change or Remove Connectors: 45
  - Define a New Environment: 25
  - Define a New Source: 41

## J
- Job Completion Code: 100
- Job Completion Description: 100
- Job Completion Detail: 100
- Job Id: 97
- Job Management Service: 10, 36
- Job Settings: 14, 55

## L
- Log Level: 103
- Logger: 10, 37

## M
- Machine Name: 98, 103
- Management Console: 14
- Metadata: 12
- Monitoring: 19

## P
- PDF Optimization: 11
- Priority: 97
- Problem Submission: 95, 111
- Process Manager: 10, 36
- Publishing: 21

## R
- Redundancy: 21
- Rule Condition: 12
- Rule Logic: 13
- Rule Order: 13
- Rule Set Editor: 13
- Rule Set Editor Page: 34
- Rule Sets: 12
- Filter Source Folders: 45
- Remove Environment Components: 30
- Sort Environment Components: 32
- Sort Source Folders: 45
- Sort Unassigned Components: 32
- Unregister an Environment Component: 30
- View Source Folder Information: 46
- Install Path: 98, 103
- Instruction Set: 14, 19
- Instruction Set Options: 58
Rule Settings Syntax ................. 70
Rules .................................. 11

S
Services ................................. 10
Source ................................. 11, 19
Source Folder Options
   Change a Connector .............. 45
   Remove Connectors ............. 45
Started On ......................... 97, 103
Status .................................. 97
System Manager ..................... 10, 35

T
Timeout Interval(s) .................... 104
Toolbox ................................ 21
Transformation Engine .............. 10, 36

U
Updated On ......................... 97, 104

V
Variables .............................. 11, 160
   Global Variables ............... 11
   Local Variables ............... 11

W
Work Area ............................. 21